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Editorial
Issue 44 – droopy drawers, all the 
fours, open two doors, magnum! 
(Nope, I haven’t gone crazy - 
although that is debatable these 
days; I just wondered what the 
bingo number calling nickname 
for 44 was. [Big grin]) OK, so 
44 issues of 2DArtist since we 
started in 2006 … how time flies! 
Thank you everyone who has 
supported us all these years, and 
welcome to those who are just 
joining us – we hope you enjoy 
the ride!

What’s in store this sunny August then? (Yep, we actually have some 
sun – I kid thee not!) First of all, let’s discuss tutorials, as I know that’s 
what most of you are here for. We have two new tutorial artists with us 
this month actually: Alex Broeckel, who you’ll have seen in our Gallery 
recently, and Bruno Werneck who featured in an artist interview in the 
2DArtist October 2007 issue have both joined the author panel. So let’s 
start at the beginning to find out what we’re up to:

Alex Broeckel brings us his interpretation of a painting created with the 
help of Google SketchUp as a base image to give some perspective 
guides and compositional help to his image creation process – speeding 
things up nicely. We gave our artists free reign over subject matter with 
these paintover tutorials, so you should see some interesting paintings 
emerge over the next few months! Click to p.64 to find out how Alex went 
about his Google SketchUp-to-Photoshop workflow. Interestingly, Alex 
uses a completely different approach to last month’s artist, so we’re keen 
to see how next month’s tutorial unfolds – looks to be a promising series!

Bruno Werneck joins us in the discussion of visual brainstorming for 
character designs on p.82. Inspired by a road trip through the mountains, 
Bruno talks us through and shows us how to go about some successful 
brainstorming to get the best out of your character concepts. The idea 
behind this series is that industry artists teach us some professional 
tips to creating better character designs. Stick with us for next month’s 
exploration of speed painting and concept design with Darren Yeow.

We also have Carlos Cabrera back with us in top form in part one of our 
brand new tutorial series on creating custom brushes. This time around 
we’re giving artists specific topics that are suited to their strengths, so 
we’ve asked Carlos to teach us how to create custom brushes for rock 
and stone textures. Check out p.76 for custom brush creation tips, as 
well as a whole set of free brushes just for our readers, created for you 
by Carlos! He’s also painted the stunning image that you’ll see on this 
month’s cover using his new brush creations. Superb!

Nykolai Aleksander is also back with us again, bringing us part two of 
our beginner’s guide to digital painting in Photoshop. We’re still talking 
technical right now, in preparation for the painting that is due to come, 
and Nykolai has been working night and day on these tutorials for you, 
teaching us all she knows. So Wacoms at the ready and thinking caps on 
– pop on over to p.92 to follow on from where we left off last month.

Well, there’s not enough room left to tell you everything else that’s great 
about this issue, so I’ll let you discover for yourselves ... Be sure to check 
out our interview with Carlos Cabrera on p.6 – absolutely stunning 
artwork there, Carlos is a real pleasure to work with and chat to! We peek 
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inside Darren Yeow’s sketchbook on p.22 to satisfy our ever increasing 
nosiness and intrigue, and Roy Stein brings us an insightful “making of” 
on p.106 talking us through the workflow used to paint recent image, A 
New Bride. A really great issue, if I do say so myself! And on my final note, 
we are waving farewell to the Stylized Challenge this month, so check 
out p.44 for the final chapter, with six making of articles from the last two 
months’ winners.

Thank you for checking out this latest issue. Enjoy and come back for 
more next month! Ed.

http://www.2dartistmag.com
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Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display;  

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.2dartistmag.com
http://www.adobe.com/products/acrobat/readstep2.html
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Darren
Yeow
27-year old self-taught 

illustrator, originally hailing 

from Adelaide, has worked as 

a concept artist, user interface 

designer and art director in video game companies 

for the past four years, and currently lives in 

Melbourne. Outside his full-time role as an in-house 

concept artist working on next-gen games, he tutors 

hopeful young artists, works on commissioned 

freelance projects, and is writing a book for those 

wishing to pursue a career in concept art.

darren@stylus-monkey.com

Carlos César 
Cabrera 
Argentina-based digital artist, 

concept artist and illustrator. 

He’s has been doing concept 

art and character designs for 

videogame companies in Argentina and around the 

world for about six years, during which time he’s 

launched a successful free video tutorial series, 

Watch and Learn, for the community. He’s been 

doing art all his life, since a child, gathering a few 

good skills from his art direction and digital painting. 

http://www.carloscabrera.com.ar

carloscabrera@gmail.com

Nykolai 
Aleksander

Born in Germany in 1978,

 Nykolai moved to England in 

1999, and currently lives in 

South Africa with her husband. 

She’s been painting digitally since 2002, and works 

as a freelance illustrator for both private clients and 

companies.

http://www.admemento.com 

x@admemento.com

Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out a bit about them. If you would 

like to be a part of 3DCreative or 2DArtist magazine, please contact: 

lynette@3dtotal.com

Would You Like to Contribute to 
3DCreative or 2DArtist Magazine?

We are always looking for tutorial artists, gallery submissions, potential 

interviewees, “making of” writers, and more. For more information, 

please send examples of your work, or a link to your online portfolio to: 

lynette@3dtotal.com

Bruno 
Werneck

He began pursuing formal 

artistic training when he was 

given a scholarship in 1996 

to study at the School of the 

Art Institute of Chicago, receiving his degree from 

Columbia College Chicago in 2002. Bruno has 

recently started his own business ‘filmpaint.com’ and 

moved to Los Angeles, California to assist production 

studios with visual development and matte painting. 

Among his recent clients are Blur Studios, Psyop, 

Zoic, Wizards of The Coast, Cisco and many others  

www.brunowerneck.com | contact@brunowerneck.com

http://www.2dartistmag.com
mailto:darren@stylus-monkey.com
http://www.carloscabrera.com.ar
mailto:carloscabrera@gmail.com
http://www.admemento.com
mailto:x@admemento.com
mailto:lynette@3dtotal.com
mailto:lynette@3dtotal.com
mailto:lynette@3dtotal.com
http://www.brunowerneck.com
mailto:contact@brunowerneck.com
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Richard G.D.  
Baker
An English/Grenadian who 

dreamt of being a stuntman, 

but for whatever reason ended 

up drawing like crazy. To 

everyone’s surprise this led him to finding work as a 

freelance cartoonist. He will soon leave England to 

live with his girlfriend, Michelle in Australia where he 

hopes to continue his artistic endeavors, play cricket 

and thrash around in go-karts! To relax, he likes to 

re-watch Firefly and Serenity. 

http://www.cirqus.com

cirqus@cirqus.com

Roy  
Stein 

A VFX artist and illustrator, 

graduate of Bezalel Academy 

of Art and Design, Jerusalem 

and the Maryland Institute 

College of Art, Baltimore. He has worked for several 

animation studios in the U.S.A., U.K., Israel and 

Thailand, and has recently opened up Studio Orso, a 

boutique VFX studio in Central Tel Aviv, Israel where 

he spends most of time doing 3D and painting. 

http://www.studiorso.com

roy@studiorso.com

Arturo  
Aguirre

An artist from Guatemala, 

currently working in advertising 

as a concept artist/illustrator 

and is looking to expand into 

the entertainment industry – where his true passion 

lies. He loves to draw his own characters and 

participate in online contests. When he’s not working 

on artworks, he enjoys spending time with his lovely 

British wife and beautiful baby girl.  

http://artinastudio.blogspot.com

artinastudio@gmail.com

Felipe 
Fernández Morell
Studied art in Montevideo, 

Uruguay. He then worked 

freelance in Barcelona in 

different media – from publicity 

to editorial to web. He’s currently working as a 

production and concept artist in the games industry.

http://www.ffilustracion.com

contactos@ffilustracion.com

Mechanic | Image by Nathaniel West

Contributors

http://www.2dartistmag.com
http://www.cirqus.com
mailto:cirqus@cirqus.com
http://www.studiorso.com
mailto:roy@studiorso.com
http://artinastudio.blogspot.com
mailto:artinastudio@gmail.com
http://www.ffilustracion.com
mailto:contactos@ffilustracion.com


Carlos Cabrera is a freelance illustrator and 

concept artist whose portfolio ranges from 

comic and book illustration through to games 

development. He has recently collaborated on 

the FEAR PC expansion, as well as starting 

work on his own video game project

“Today an artist can get 
a 12 inch Cintiq and work 

from a local coffee
shop with his laptop. That 

is a freedom we didn’t 
have before”
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Carlos Cabrera Interview

Perhaps, Carlos, you could start by telling us a 

little about yourself, your background and how 

you came to work in the industry?

I started to do illustrations as far back as I can 

remember, but have been working commercially 

for about 12 or 14 years now. I’m very grateful 

to have found my space in the entertainment 

business, although I don’t rule out the possibility 

of doing a movie project in the future.

In Argentina it is pretty hard (if not impossible) 

to find a good art institute so I had to study by 

myself (best school ever!) with comics and any 

art books I could find. Since the internet popped 

up all over the world I’ve been able to develop 

myself as a professional artist.

When I was 22 years old I began to work at a 

local video game startup here in Buenos Aires, 

where I got access to a Wacom tablet (back in 

the day it was impossible to buy one of these 

when they first came out; they were really 

expensive even in the USA). Using a Wacom 

was a blessing for me so I used to stay after 

hours just to practice with it.

The first project I was involved with was a 

GameBoy Advance game in which I did lots of 

pixel and regular art. In all the years I worked 

for that company I learned a lot from practicing 

every day. After the project was finished I 

moved to work with TimeGate Studios when 

they were just starting on Section 8 (an AAA 

game still under development - http://www.

joinsection8.com/) 

I learned how to work for an American company 

through TimeGate, which was something 

http://www.2dartistmag.com
http://www.joinsection8.com/
http://www.joinsection8.com/
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completely different for me because of the level 

of quality they required and the deadlines they 

usually worked within. I was amazed by that!

While all this was happening I kept up my 

freelancing work for local companies and 

startups (I even helped a comic book artist!).

My work relation with TimeGate was growing 

to the point where they actually offered me the 

chance to travel so that I could work with them 

in the USA for a whole year. I couldn’t take that 

offer because of family problems, but we kept 

working together. During that last project we 

began working on the FEAR PC expansion and 

on some internal projects. During that time I 

also worked on several illustrations for Privateer 

Press, wrote a couple of tutorials for some 

textbooks from China and collaborated with 

Bobby Chiu on a publication.

Right now I’m working with my brother on our 

first video game project. We are really excited 

about creating a company and all the steps 

involved over the next few months, but I can’t 

give much detail about it because it’s a work in 

progress. All I can say is that we are trying to go 

back to better times in video game history, when 

the gameplay and quality overruled “fashion” 

http://www.2dartistmag.com
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in games, which should be enough to give you 

guys goose bumps!

It sounds as though you have had an interesting 

career path so far, but what are the main 

advantages and disadvantages of working 

remotely for companies? And is your video 

game a full time project now?

One advantage is the different time zones 

between countries. With this you can be working 

all day while your client is at the other side of 

the world having a good night’s sleep. First thing 

in the morning he gets an email with the work 

done and that’s something in-house art teams 

can’t compete with most of the time.

On the other hand, I get more freedom to 

work around my priorities and be able to meet 

all my clients’ deadlines without much effort. 

The advantages are many yes, but there are 

also big responsibilities. Freelance work gives 

you a direct link with the client; there are no 

supervisors, no art directions, and no bosses in 

the middle. It’s you, your work and the client; no 

excuses.

I don’t find many disadvantages in working 

offshore. The fact you can actually handle the 

http://www.2dartistmag.com
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amount of clients, plus the work flow, the way 

you want to is priceless. Maybe the only big 

disadvantage I can bring to the table is the lack 

of continuous clients. You can spend a whole 

week without having a client, but you are usually 

finishing something else so I still really enjoy 

working offshore.

About the video game project; no it’s not full 

time work yet but we are slowly making more 

time for it. We have an amazing product in the 

works here with this video game, so there’s no 

turning back for us now.

You have a number of pieces relating to the 

video game FEAR. Can you describe what 

this was like as a project and the challenges it 

presented?

It was a very interesting and challenging 

project because doing background art has 

never really been my strong point. Generally 

speaking, I’d rather make characters, monsters 

or design weapons. That day I remember the 

TimeGate art director contacted me, asking if 

I was interested in working freelance on a few 

backgrounds that they needed. He sent me an 

example and that very same day I was up all 

night working and practicing, trying to match the 

quality they sent me.

After I sent them the outcome (a pretty horrible 

background if I look at it today) the TimeGate 

art director gave me the chance of working 

on the project with them, so we started with a 

set of three backgrounds. The first one took 

me the whole day and after his feedback I had 

lots of errors to fix, but the second one came 

up much faster and after that I was delivering 

approximately one finished background per 

day before starting on the next one. I was a 

background vending machine!

On many of the backgrounds I used the 

help of 3D software to avoid dealing with the 

perspective and to get a quick light and shadow 

base to work with. My 3D skills are pretty much 

nonexistent, so I was limited to boxes and pipes 

with the software (nothing fancy). The work I 

did for FEAR was varied; I did backgrounds, 

characters and weapons. It was pretty good fun!

There is a wide variety of work in your portfolio 

but which rank among your favourites and why?

As I mentioned before, I love to illustrate 

characters more than backgrounds, but what I 

http://www.2dartistmag.com
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really love more than anything is (when I have 

the chance) to work on monsters or creatures. 

Maybe it’s because it is something much more 

creative and I don’t have to think that much 

about the clothes or the human anatomy. 

Creating a monster or creature is something 

that comes completely from your imagination; 

you don’t see yourself limited with anatomy or 

art references. A specific story also helps the 

artistic job flow faster and you can get a better 

result in less time.

I understand what you mean about creatures 

being a great stimulant for the imagination, but 

it nevertheless remains difficult to come up with 

wholly original designs. Which creatures have 

you seen, either in films or video games, that 

you really feel are quite original?

The Faun of Pan’s Labyrinth is one of my 

favorite creatures; another is the Cloverfield 

monster. I really enjoy the work and quality of Guillermo Del Toro; I 

believe he is a great visionary and one of the few directors out there 

designing his own characters. In the video game field I really loved the 

Fable 2 designs and obviously, the monsters of God of War (I became 

addicted to that one!)

Tools like Photoshop and Painter are continually developing new features 

but where do you feel the main advances have been in digital art over the 

last few years?

I believe something to highlight should be the hardware and software 

growth in the last ten years, which has been enormous. Today we have 

the chance of using digital pens, tablet PCs and pen displays: back in the 

days all this stuff was just in our imagination. To give you a quick example: 

for the first digital pen I used, the pen was actually wired to the drawing 

area and the drawing area was the size of a credit card. We have come a 

long way since then!

Today an artist can get a 12 inch Cintiq and work from a local coffee shop 

with his laptop. That is a freedom we didn’t have before. The other side of 

the story is that a lot of new artists don’t even know about the traditional 

ways (pencils, oils, acrylics) and that shows up in their final work (always). 

“Today an artist can get a 12 
inch Cintiq and work from a 

local coffee shop with his laptop. 
That is a freedom we didn’t have 

before”

http://www.2dartistmag.com






Most companies out there want the traditional 

look on their digital illustrations. Old school my 

friend!

Many of your environment designs show 

accurate perspective in some of the details 

such as the floor panelling. Do you use 3D 

scenes often as an aid to your concept 

process?

Yes, I use basic 3D on lots of my 

illustrations. My knowledge of 3D is 

basic to medium and the delivery time 

is almost one illustration per day so 

I can’t spend much of my time on a 

complex 3D model because I have to 

work on it later.

A lot of times I get comments from 

artists asking if they should use a 

render as a base for their illustrations 

and if it is “cheating” and will some 

companies look at it the wrong way. My 

answer is always the same: if a company gets 

a quality piece of work in a short span of time, 

they don’t care if you used 3D, family photos 

or you painted it with oils. It is a new tool that 

makes our work easier, why shouldn’t we use 

it? In other illustrations I also used ZBrush, 

for example, to create stone textures or even 

planets!

You talk about speed, which is an obvious 

asset necessary in your line of work, but apart 

from using 3D what painting techniques have 

you developed to help quicken your character 

design process?

One simple way of doing it is working on an 

initial sketch with the Photoshop “Lasso” tool 

(look it up, its right there!) The main idea of 

this technique is to “draw” a selection of what 

we want to paint and with a simple brush we 

can quickly paint inside that selection. After we 

have the shape completely filled with our base 

color, we use the same lasso tool to select the 

shadows and we paint them with a darker color.

At the end we do the same for the lights; this 

way we have a very quick sketch with a superior 

quality that would have taken us twice the time 

to do in the traditional way. This technique is 

handy for me, whilst some other artists would 

rather do the sketch in pen and color. The best 

thing to do is to try new techniques until you find 

the one you are comfortable with. It’s all about 

having good quality and working fast!

Of the other artists out there, whose work has 

inspired you the most?

That’s a tough one. I have a long list of artists 

that inspire me and I’m going to make the effort 

to name a few: I believe Emrah Elmasli is one 

of my favorites; I really envy the way he works 

the color and design on his illustrations. Another 

one whose work I follow very close is Svetlin 

Velinov - I still don’t get how he can paint like 

that with Photoshop! It’s amazing! And of course 

I’m influenced a lot by the style of Brom, Bisley, 

Frank Miller and Chad Townsend.

What is it, do you think, that sets the good 

concept artist apart from the average? And what 

do you feel are the key ways to improve ones 

work?

I believe I’m stilling looking for that answer 

myself [Laughs]! What helped me this last 

year was basically delivering projects fast and 

with high quality. Generally speaking it takes a 

couple of weeks for any artist to deliver a high 

quality painting, illustration or anything. I try to 

do the same in half the time. It’s also a good 

move to show your work in any forum, book or 

magazine you can find.

Having your own website with your portfolio 

online is one of the steps that any artist can do. 

The world is full of clients who are waiting to see 

“The best thing to do is to try new 
techniques until you find the one 

you are comfortable with”
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examples of your work! You just need to show 

them! Companies are always on the hunt for 

new artists and they usually have subscriptions 

to different specialized magazines, forums or 

websites. Back in the days I remember getting 

an email from Microsoft Games to work in-

house in one of their MechWarrior projects, but 

I couldn’t at the time for personal reasons. I 

remember the project art director and some of 

Microsoft artists had seen my work and tutorials 

on the web.

If Microsoft choose to make contact with a 

person on the other side of the globe to make a 

work offer, I don’t understand how some artist 

can’t take advantage of the opportunities they 

have in their own home countries (I’m looking at 

you, USA citizens!) where companies like this 

are two blocks away from where they live.

To sum up: the best thing to do to set yourself 

apart from the bunch is to get your work out 

there and work every day on your speed and 

quality.

And a quick pointer for everyone who wants 

to get better: focus on quality and render skill. 

That’s a basic exercise I always recommend; 

search for some illustration from your favorite 

artist (you can start by going to http://www.

carloscabrera.com.ar/) grab a bit of that 

illustration (can be a hand, a leg, a face) and try 

to reproduce it every day.

If you do an illustration in the morning and one 

at the night, I can guarantee that without even 

noticing your final render will have improved 

considerably in just a few weeks. Peace! 

Thanks for taking the time to talk to 2DArtist 

Carlos!

Thank you sir for giving me the opportunity of 

showing everyone what I do. Speaking of which, 

I invite you all to drop by my website and enjoy 

some of my new work and tutorials. I promise 

you that the free “Watch and Learn” series 

will come back in a short while for the artistic 

community to enjoy out there! Thanks!

Carlos Cabrera
For more work by this artist please visit:

http://www.carloscabrera.com.ar/ 

Or contact them at:

carloscabrera@gmail.com

Interviewed by: Richard Tilbury

“The best thing to do to set yourself apart from the bunch is to get 
your work out there and work every day on your speed and quality”

http://www.2dartistmag.com
http://www.carloscabrera.com.ar/
http://www.carloscabrera.com.ar/
http://www.carloscabrera.com.ar
mailto:carloscabrera@gmail.com
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Darren Yeow Sketchbook

Sketchbook of 
Darren Yeow

Anatomy 
Studies
This page of sketches is an example of an 

anatomical study sheet (Fig.01). It is not 

intended to be aesthetically pleasing in any 

way, it is simply a quick revision exercise of 

jotting down information that you have been 

learning in summary form. 

It was handled with pen and paper, and 

it took roughly half an hour to execute. It 

was a revision exercise so there wasn’t any 

reference to existing textbooks or anatomical 

sheets – just me, a pen and a piece of paper!

Michelangelo Study

This was a study I did in order to tackle two things: to 

revise my anatomical knowledge of the back muscles 

(which incidentally receive far less fanfare than those of 

the opposing forward facing muscles of the torso), and to 

study the aesthetics of Michelangelo’s own studies for his 

Libyan Sibyl (Fig.02).

This was a piece done in graphite on some regular copy 

paper, and served as a tutorial piece that I put on a 

couple of forums to demonstrate the use of grids to plot 

major landmarks to allow for correct proportions.

http://www.2dartistmag.com


Mona Lisa Study
This was another study of a Master’s work 

(Fig.03). The Mona Lisa has always been a 

source of fascination for me, not because of 

its notoriety or its execution, but because I 

honestly didn’t think it was a very special 

piece – especially when compared to 

many other works I have seen. When 

I undertook the piece, because of the 

timeframe it took to study and copy, 

I gained a richer appreciation for 

the subtlety of the painting. I also 

learned a great deal of patience 

copying the famous dame’s facial 

expression, which even now eludes 

the quality of the original – her 

almost expressionless face that 

hints at something just beyond 

comprehension. I think mine is a little 

too happy?



The Man-Made
This is a relatively common looking page of 

sketches from my pads, concentrating on line 

work, readability and form (Fig.04). This page 

deals mainly with man-made objects, or a fusion of 

man-made objects with organic composition, which 

naturally flow out of the stroke of whim, rather than 

purpose.

Of all my different rendering styles and types of 

work I do, I tend to enjoy the low-tech feedback 

of pencil or pen on paper, the immediacy and the 

rawness of the lines which are undoctored, the 

feel of fighting the friction against the surface of 

the paper, trying to create meaningful marks while 

simultaneously emptying the mind of preconceived 

notions – an aspiration I probably don’t achieve 

most of the time, although I duly try.

More AnatomyHere is another page of anatomy studies (Fig.05). I find the human body to be an endless source of configuration and inspiration – on the surface of it all a beauty so simple 
and balanced, and yet holding a quality so nuanced and difficult to achieve.

This sketchbook page holds the typical level of rendering I like to imbue on my studies; any less shortchanges the study of form, any more becomes prohibitive on that most 
precious of resources: time.



Sketching with a Cintiq
About a year ago I invested in a 12WX. I was a little hesitant because of 

the price point, the possibility of lag on my underpowered PC, and whether 

it would bring any major advantage to just scanning my sketches in and 

rendering with a regular Intuos tablet. Let me tell you: there is a slight 

learning curve coming from Intuos to Cintiq, but my workflow efficiency 

has really improved markedly and I mostly skip the penciling stage for 

most of my work now. These are just a couple of purely digital sketches 

that took probably half the time that it would have taken had I used a 

combination of sketching manually, and then rendering digitally (Fig.06). 

On this particular sketch “sheet” I was concentrating on the form and light 

source to define the subject matter.



Characters
These two characters were done for 

various indie games – in both, there is 

marked attention given to their silhouettes 

as well as form (Fig.07a – b). With these 

types of sketches, I try to give a sense of 

character through their mannerisms, postures 

and accompanying accoutrements. 

As an aside, working on some low paying 

indie games is actually something I really 

enjoy doing from time to time; it helps me 

bolster my portfolio and gives a little back to a 

community from whence I came. The money 

I generally receive for these “commissions” is 

generally barely enough to pay for the amount 

of electricity I use to power my laptop while 

undertaking said commission, but they do give 

a degree of freedom that is hard to solicit 

while working at a big company.

These were created with rough sketches 

and rendered in Photoshop. Regarding the 

feel of the pieces, I have never been one to 

pursue the digital aesthetic that screams, 

“Computer art!” I tend to prefer the look of 

graphite (or some other traditional media) 

to my images, and I achieve most of this by 

incorporating scans of whole pages toned 

with graphite (or paint or watercolor), and 

apply it digitally in my illustration program.
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Various Sketches
Here are some other exploratory sketches done for various companies 

and projects (Fig.08). Most of them were done to help determine the 

look and feel of a project, and I tend to enjoy these blue sky images the 

most, as opposed to working to a predefined style over which I have 

no real say – although I do gain a lot of satisfaction from nailing other 

styles that are not my own as well.

The top piece shown in Fig.09 is a color sketch from a visual reference 

done entirely in Corel Painter. I didn’t spend much time on the minute 

details, preferring to spread the focus across the whole image, giving it 

a nice not-quite-impressionistic feel to the piece. The lower two images 

of Fig.09 were more exploratory pieces for a previous soccer project I 

worked on.

In Fig.10, the top image was a piece I did while learning how to create 

textures. I enjoyed giving the piece a painterly feel whilst creating 

a pretty abstract looking piece. The image below in Fig.10 was an 

exercise about letting go and doing things as they occurred to me, not 

really worrying too much about detail, but about overall form and balance.

Well, I hope you’ve enjoyed my thoughts on some of my sketchbook 

pages and have hopefully picked up one or two interesting bits of 

information from all this. If you have any questions or comments please 

feel free to send me an email at. Until next month, keep drawing!

Darren Yeow
For more from this artist contact them at:

darren@stylus-monkey.com

http://www.2dartistmag.com
mailto:darren@stylus-monkey.com
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: volume 4

Buy the book to see just how 
they create their incredible 

imagery!���

Features 50 of the finest digital 
2d and 3d artists working in the 
indusrty today, from the likes of:

Loïc e338 Zimmermann | James Paick

Craig Sellars | Jelmer Boskma

Maciej Kuciara | Daarken| Marek Denko 
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Marek Okoń

“Digital Art Masters is getting 
better and better at showcasing 

some of today’s best digital 
artists. The way the book shows 

the processes of achieving 
great pictures provides a good 

opportunity to learn from these 
artists, and keeps you challenged 

in your own Art.”
Raphael Lacoste | www.raphael-lacoste.com/

Hardback - 21.6cm x 27.9cm in size 

288 Full Colour Premium Paper Pages 

ISBN: 978-0-240-52171-8

http://www.3dtotal.com/damv4
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This Month we Feature artwork from:

Andreas Rocha

Aziz Maaqoul

Nathaniel West

Dona Vajgand

Serge Birault

Arnaud Valette

Krzysztof Bielenin

Irvin Rodriguez

Dmitry Mitsuk

Paul Gerrard
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Distant Lands
Andreas Rocha 

(Below)

http://www.andreasrocha.com 

rocha.andreas@gmail.com

© Imagine Publishing, Courtesy of The Official Corel Painter Magazine

A Farewell to Arms
Dmitry Mitsuk 

(Above)

http://mitsuk.cgsociety.org/gallery

mitsuk2003@list.ru

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://www.andreasrocha.com
mailto:rocha.andreas@gmail.com
http://mitsuk.cgsociety.org/gallery
mailto:mitsuk2003@list.ru
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Mechanic
Nathaniel West

http://nathanielwest.net

nathaniel@nathanielwest.net

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://nathanielwest.net
mailto:nathaniel@nathanielwest.net
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Image Title
Artist Name

Website Address 

Image Title
Artist Name

Website Address 

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
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The Emperor
Dona Vajgand 

(Right)

http://d-na.deviantart.com/

late.goodbye@gmail.com

Birdy
Arnaud Valette 

(Left)

http://www.arnaudvalette.com

arnovalette@gmail.com

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://d-na.deviantart.com
mailto:late.goodbye@gmail.com
http://www.arnaudvalette.com
mailto:arnovalette@gmail.com


Sashimi’s Revenge
Serge Birault

http://www.sergebirault.com/

serge.birault@hotmail.fr

http://www.sergebirault.com
mailto:serge.birault@hotmail.fr
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La Mirada
Irvin Rodriguez 

(Right)

http://irvinrodriguez.blogspot.com/

irvone@gmail.com

The Island of Medusa
Aziz Maaqoul 

(Below)

http://www.maaqoul.com

azizmaaqoul@yahoo.fr

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://irvinrodriguez.blogspot.com
mailto:irvone@gmail.com
http://www.maaqoul.com
mailto:azizmaaqoul@yahoo.fr


The Chase
Paul Gerrard

http://www.butterflysoldiers.com 

pgerrard@butterflysoldiers.com 

 

The Chase by Paul Gerrard is just one of 

a collection of stunning images from artists 

all around the world, created as part of 

Justin Lassen’s Synaesthesia project. We 

catch up with Justin in next month’s issue 

with a special artist-on-artist interview by 

Nykolai Aleksander, so check back in with 

us in September to witness more fantastic 

images like this one, which inspired the 

haunting sounds of Justin Lassen.

© PAUL GERRARD

http://www.butterflysoldiers.com
mailto:pgerrard@butterflysoldiers.com


Fly Away
Krzysztof Bielenin

http://www.bielenin.com

kb@bielenin.com

http://www.bielenin.com
mailto:kb@bielenin.com


© Krzysztof Bielenin
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Vancouver Film School alumni credits include Across the Universe Geeta Basantani, 
Digital Compositor Alias Scott Dewis, Visual Effects Artist Babel Luis Blackaller, 
Storyboard Artist | Lon Molnar, Visual Effects Supervisor Battlestar Galactica Daniel 
Osaki, Lead Modeler | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Bioshock 
2 (VG) Jacob Palmer, Animator  Bolt Lino Di Salvo, Supervising Animator/Voice of 
Vinnie Charlotte’s Web Aruna Inversin, Digital Compositor | Adam Yaniv, Character 
Animator | Tony Etienne, Lead Lighter | Kristin Sedore, Lighter The Chronicles of Narnia: 

Prince Caspian Andreas Hikel, Pre-Visualization Artist | Christoph Schinko, Character 
Animator | Jami Gigot, Senior Layout Artist Cloverfield Nicholas Markel, Pre-Visualization 

Supervisor Constantine Aruna Inversin, Digital Compositor The Dark Knight Pietro Ponti, 
Lead CG Lighting Artist Dead Like Me Daniel Osaki, Visual Effects Artist | Alec McClymont, 3D 

Artist Diablo III Alvaro Buendia, Cinematic Artist | Steven Chen, Cinematic Artist District 9 Neill 
Blomkamp, Director | Shawn Walsh, Visual Effects Executive Producer | Jelmer Boskma, Modeler  

Bernhard Kimbacher, Compositor | Julianna Kolakis, Creature Texture Painter | Adam Marisett, Visual 
Effects Artist | James McPhail, Visual Effects Technical Director | Dominic Cheung, Lighting Technical 
Director | Grant Wilson, Animator | Joey Wilson, Modeler Family Guy Michael Loya, Storyboard Artist 
Fantastic Four: Rise of the Silver Surfer Arun Ram-Mohan, Lighting Technical Director | Shawn 
Walsh, Visual Effects Executive Producer | Jessica Alcorn, Compositor Gears of War (VG) Scott 
Dossett, Animator G.I. Joe: The Rise of Cobra Allen 
Tracy, Visual Effects Editorial Supervisor | Aruna 
Inversin, Digital Compositor Jeremy Stewart, 
Senior Animator | Jelmer Boskma, Modeler The Godfather (VG) Kirk Chantraine, Motion Capture 

Specialist The Golden Compass Adam Yaniv, Animator | Chad Moffitt, Animator | Thom Roberts, 
Animator | Ben Sanders, Animator | Andrew Lawson, Animator | Matthias Lowry, Visual Effects | Tony 

Etienne, Look Development | Justin  Hammond,  Lighter | Pearl Hsu, Effects Technical Director | Aruna Inversin, 
Digital Compositor | Fion Mok, Matchmove Artist Hairspray Lon Molnar, Visual Effects Production Executive 

Halo 3 (VG) Bartek Kujbida, Character Animator Happy Feet Ben Sanders, Character Animator | Thom Roberts, 
Character Animator Harry Potter and the Prisoner of Azkaban Shawn Walsh, Color & Lighting Technical Director 

Harry Potter and the Order of the Phoenix Pietro Ponti, Technical Director Harry Potter and the Half-Blood 
Prince Harry Mukhopadhyay, Lead Effects Technical Director Hellboy II: The Golden Army Christoph Ammann, 3D 

Sequence Supervisor Horton Hears a Who Arun Ram-Mohan, Lighting Technical Director | Brent Wong, Modeler Hulk 
Geoff Richardson, Visual Effects Editor I, Robot Daniel Osaki, CGI Modeler | Megan Majewski, Pre-Visualization Ice Age: 
The Meltdown Ben Sanders, Character Animator | Arun Ram-Mohan, Lighting Technical Director The Incredible Hulk 
Shawn Walsh, Visual Effects Executive Producer | Tony Etienne, Look Development Lead The Incredibles Daniel 

Holland, Animator Indiana Jones and the Kingdom of the Crystal Skull Henri Tan, Creature Technical Director 
Iron Man Adam Marisett, Visual Effects Artist King Kong Chad Moffitt, Senior Animator King of the Hill Michael 

Loya, Director Kingdom Hospital Daniel Osaki, Visual Effects Artist | Megan Majewski, 3D Animator | Alec 
McClymont, 3D Artist Kingdom of Heaven Shawn Walsh, Digital Compositor Left 4 Dead (VG) Nick Maggiore, 
Animator Letters from Iwo Jima Aruna Inversin, Digital Compositor Live Free or Die Hard Jessica Alcorn, 
Compositor Lord of the Rings Trilogy Chad Moffitt, Senior Animator Lost Scott Dewis, Visual Effects Artist 
Mass Effect (VG) Sung-Hun (Ryan) Lim, 3D Modeler Matrix: Revolutions Aruna Inversin, Digital Compositor 
Shawn Walsh, Color & Lighting Technical Director Master & Commander: The Far Side of the World 
Robert Bourgeault, CG Artist Metal Gear Solid 4 (VG) Josh Herrig, Artist | Yuta Shimizu, Artist The Mummy: 
Tomb of the Dragon Emperor Aruna Inversin, Digital Compositor Persepolis Marianne Lebel, Animator 
Pirates of the Caribbean: At World’s End Ben Sanders, Character Animator | Allen Holbrook, Animator 
Aruna Inversin, Digital Compositor The Pirates Who Don’t Do Anything: A VeggieTales Movie Mike 
Dharney, Animation Supervisor Reign of Fire Lino DiSalvo, Animator Resident Evil: Extinction Joshua 
Herrig, Visual Effects Artist Robots Arun Ram-Mohan, Additional Lighting Rome Teh-Wei Yeh, Matchmove 

Artist Scarface (VG) Maya Zuckerman, Mocap 3D Generalist Shrek the Third Rani Naamani, Animator 
Shrek the Third (VG) Samuel Tung, Technical Artist Sin City Michael Cozens, Lead Animator Smallville 

Geeta Basantani, Lead Compositor Star Trek Aruna Inversin, Digital Compositor | Tom Piedmont, 
Digital Plate Restoration Star Wars Episode III: Revenge of the Sith Andrew Doucette, Character 

Animator |  Nicholas Markel, Pre-Visualization Star Wars: Knights of the Old Republic (VG) Arun 
Ram-Mohan, 3D Artist | Jessica Mih, Level Artist Stargate: Atlantis Daniel Osaki, 3D Animator 

Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Sweeney Todd: The Demon Barber 
of Fleet Street Jami Gigot, Concept Artist Terminator Salvation Teh-wei Yeh, Lighting Technical 

Director | Geeta Basantani, Digital Matte Painter Transformers: Revenge of the Fallen Bryan Jones, 
Compositor | Aruna Inversin, Digital Compositor | Henri Tan, Creature Technical Director | Teh-wei Yeh, 

Digital Artist | Stephen King, Animator Twilight Geoffrey Hancock, Digital Effects Supervisor Unreal 
Tournament III (VG) Scott Dossett, Artist Valiant Robert Bourgeault, Lighting Technical Director WALL-E  
Mark Shirra, Layout Artist | Bill Watral, Effects Artist | Daniel Holland, Production Artist Watchmen Lon 

Molnar, Visual Effects Supervisor World of Warcraft: Burning Crusade (VG) Carman Cheung, 
Animator Warhammer 40,000: Dawn of War II (VG) Ian Cumming, Senior Artist | Nathan Hocken, 

Lead Animator A Wrinkle in Time Aruna Inversin, Digital Compositor and many more.

Your name here.

VFS student work by Thiago Martins

http://www.vfs.com/animationvfx


Welcome to the Challenge section of 

2DArtist. Since December 2006 we 

have run a monthly challenge over on 

ConceptArt.org and in 2DArtist, giving 

the digital painting community the chance 

to enter for prizes from the 3DTotal web 

shop, and for the opportunity to have their 

work featured in this very magazine. 

After 31 successful challenges, we 

are now taking a break – much to 

the disappointment of all our regular 

challengers, I know, but we hope to 

bring the challenge feature back again 

in the near future, so we’ll look forward 

to seeing you all there! In the meantime, 

please enjoy the last-for-a-while Stylised 

Challenge article, where you can see 

the winners of the final Amazon Woman 

Warrior challenge, alongside some great 

making of articles from not only this 

challenge, but last month’s Robots one, 

too!

Amazon
Stylised Character challenge

http://www.conceptart.org/forums/
http://www.3dtotal.com/


page 45 Issue 044 August 2009www.2dartistmag.com

Amazon Stylised Character Challenge

The Stylised Animal 
Challenge – Amazon
Welcome to the final monthly challenge in 

2DArtist magazine (for a while, at least). 

For the past 31 months we have selected a 

topic, plucked from the strange imaginations 

of the 2DArtist team – and more often than 

not our challengers, too – and then posted 

images over on ConceptArt.org for all to see 

and use as inspiration. We have then relied 

on the minds and talents of the ConceptArt.

org forum members to come up with the weird 

and wonderful stylised concepts that you will 

have seen over the past three years within our 

challenge articles.

We are sad to announce that the Amazon 

Warrior Woman is the final stylised challenge 

that we’ll be running, but we certainly hope to 

come back with something new for everyone to 

get involved in as soon as we can, so for now 

we bring you the final stylised challenge article. 

[Sob] To take us out in style we’re not only 

showing the top ten winners from the Amazon 

challenge with the top three making of articles 

from last month’s Robots challenge, but we’re 

Angela - Angel Intheuk  
angel.b79@googlemail.com

10th

Jason Smith - Macaruba  
info@macaruba.com

http://www.macaruba.com

9th

Leo - blackcherry  
leo@almasy.zzn.com

http://www.biscuitofdoom.net

9th9th

Ray Williams - artiphats 
art1phat@hotmail.com 

http://raysartonline.com/

8th

Kai Schüttler - Gun Trouver  
kai.schuettler@gmail.com

http://monoxide-art.blogspot.com

also bringing you making ofs from our Amazon 

winners, too. So dry those eyes and indulge in a 

bit of community love as we wave farewell to our 

dear friend: the Stylised Challenge. 

If you have any words of support, regret, 

annoyance, or any other thoughts about the 

ending of the Stylised Challenge, you are more 

than welcome to join our current and previous 

challengers and share your thoughts over on 

this forum thread. Thank you for your support!

What have we been 
looking for?
Funny and humorous entries which break 

the subject down to its most recognisable 

components. We ask our challengers to 

emphasise these characteristics in whichever 

http://www.2dartistmag.com
mailto:angel.b79@googlemail.com
mailto:info@macaruba.com
http://www.macaruba.com
mailto:leo@almasy.zzn.com
http://www.biscuitofdoom.net
mailto:art1phat@hotmail.com
http://raysartonline.com/
mailto:kai.schuettler@gmail.com
http://monoxide-art.blogspot.com
http://www.conceptart.org/forums/showthread.php?t=162000


page 46www.2dartistmag.com Issue 044 August 2009

Stylised Character Challenge  Amazon

Sean Thurlow - Trashy 
deadite44@hotmail.com 

http://trashyworks.blogspot.com/

7th

Richard G.D. Baker - The Antartican 
cirqus@cirqus.com 

http://www.cirqus.com

6th

Tom van Wanrooy - Tommoy 
info@thecartoonfactory.nl 

http://www.thecartoonfactory.nl

5th

Tsolmonbayar Batbaatar  - GRMC 
grmcx_xac@yahoo.com

5th

ways they think best, and to render their 

stylised/abstract/cartoon masterpieces to share 

with the world through the electronic pages of 

ConceptArt.org and 2DArtist magazine. Winners 

of our challenges have then been asked to show 

the stages of creation of their winning concepts 

– different elements and some brief explanation 

text – of why, and how, they did what they did. 

This then gets formatted into the rather fetching 

pages you’ll find here within this article. 

We hope you will enjoy the results of the final 

challenge - one which we quite honestly think 

has knocked the socks (and bras, in some 

cases) off some of our other challenges. We 

give thanks to everyone who have supported 

the challenges over the last three years, and to 

those who have helped this final challenge go 

out on a high. Thank you, and enjoy!

http://www.2dartistmag.com
mailto:deadite44@hotmail.com
http://trashyworks.blogspot.com/
mailto:cirqus@cirqus.com
http://www.cirqus.com
mailto:info@thecartoonfactory.nl
http://www.thecartoonfactory.nl
mailto:grmcx_xac@yahoo.com


page 47 Issue 044 August 2009www.2dartistmag.com

Amazon Stylised Character Challenge

Rosa Hughes - rosatron 
rosatron@gmail.com 

http://www.rosatron.com/

4th

Marc Garcia - Marcuswelbey 
two2lions@gmail.com

3rd

Jan Pedroietta - jpedro 
jpedro@jpedro.com 

http://jpedro.cgsociety.org/gallery/

2nd

Felipe Fernández Morell - bstsk 
contactos@ffilustracion.com 
http://www.ffilustracion.com

1st

http://www.2dartistmag.com
mailto:rosatron@gmail.com
http://www.rosatron.com/
mailto:two2lions@gmail.com
mailto:jpedro@jpedro.com
http://jpedro.cgsociety.org/gallery/
mailto:contactos@ffilustracion.com
http://www.ffilustracion.com


page 48www.2dartistmag.com Issue 044 August 2009

Stylised Character Challenge  Amazon

Making Ofs
Here are the ‘Making Of’ from last month’s top 3 

winning entries...

3rd Artina 
Software Used: Photoshop 

Step 01 
After some quick sketches that weren’t really 

turning me on, I decided to go with an image 

paying homage to the Sistine Chapel painting 

by Michelangelo. I used a custom brush that I 

created myself which I love to sketch with – it 

has the feeling of a palette knife that gives 

me some nice thick and thin lines, and happy 

accidents tend to occur from it that I can take 

on and work with further (Fig.01). Try this 

for yourself: Take a round brush, lower the 

Roundness to 10%, Angle to 90, set the Spacing 

to 1%, Size Jitter to Pen Pressure, Angle Jitter 

to Pen Tilt, and set Flow and Opacity Jitter to Pen Pressure. Have some fun with your 

brushes!

Step 02
I created a new layer on top of my sketch and 

set it to Color blending mode. I wanted to use 

contrasting colors to make the character “pop” 

from the background. These were basic colors 

that complemented each other nicely. I created 

another new layer on top, set to Normal this 

time, to define the character a bit more using the 

same color palette (Fig.02).  

Step 03
I defined the character and drapery a bit more 

in this next step. I was still experimenting with 

the design of the robot; I wanted it to be a 

simple design that was easily recognizable as a 

humanoid robot. The pose was very important 

because it had to hearken to the Sistine Chapel 

painting, soothe robot’s wires and buttons 

were kept to a minimum in order to avoid any 

confusion (Fig.03).  

Step 04
I flipped the canvas horizontally at this stage to 

see if the piece worked any better the other way. 

I added the yellow to keep the colors basic and 

high in contrast. I also made some changes to 

the drapery because I wasn’t getting the feeling 

I was hoping for. I also added some details to 

the limbs and gave the green metal a textured 

feel by painting in different angles and smudging 

(Fig.04).  

Step 05
I kept defining the lights and darks, adding more 

detail and bounced lighting on the character. 

I added a rusty texture which I found online 

to give the bluish-green parts some more 

character, as well as giving a reactor detail to 

the eyes and chest plate (Fig.05).  

http://www.2dartistmag.com
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a Levels Adjustment Layer and Layer Mask, 

erasing those parts that I wanted to act as the 

lights with a soft brush. And that was it – done 

(Fig.07)!

Step 06
I used the Burn and Dodge tools to punch up 

the contrast between the lights and darks here, 

as well as a Levels Adjustment Layer to achieve 

the same goal. And it was at this stage that I 

painted in the hand of the scientist meeting that 

of the robot. Referencing Michelangelo’s piece I 

added some pink bounce lights onto the palm of 

the man’s hand to make it sit a little better in the 

scene (Fig.06).  

Step 07
In the final step I added a new Gradient Layer 

(magenta to green), set it to Overlay and 

lowered the Opacity to about 20% or less. I 

copied the layer, and to enhance the lighting 

effects I focused an omni light behind the two 

hands to draw attention to them. I continued 

refining the details until I was happy, then I 

flattened the image, copied the resulting layer 

and added the High Pass filter to it (Filter > 

Other > High Pass). I then set the new layer 

to Soft Light and lowered its opacity, adding 

Arturo Aguirre
For more work by this artist please visit:

http://artinastudio.blogspot.com 

Or contact them at:

artinastudio@gmail.com

http://www.2dartistmag.com
http://artinastudio.blogspot.com
mailto:artinastudio@gmail.com
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2nd The Antarctican
Software Used: Illustrator, Photoshop

Hello to all who read 2DArtist magazine! This 

is my first time featuring in the magazine with a 

‘making of’ to explain my process when creating 

images for the Super Stylized Challenges. I’d 

just like to say thanks to everyone who voted for 

me, I really appreciate it!

I wasn’t going to enter the Robot challenge 

originally, as I was away in Australia at the time 

and I didn’t have any of my usual kit to work 

with. So my initial sketches were pretty much 

a loose affair that I thought I would do nothing 

more with. But when my girlfriend, Michelle saw 

the image of Tiq Taq – 1901, she suggested that 

I give it my full attention (Fig.01).

The idea behind Tiq Taq is that he’s a steam-

driven robot from the Victorian era, who, in 

order to survive, has constantly had to upgrade 

himself to accommodate the various trends that 

the eras he’s lived through have demanded. The 

narrative is perhaps clearer to me, but I often 

like to establish a story like this to give me a

certain focus when I’m drawing. It also allowed 

me an excuse to indulge in two of my main 

obsessions: steampunk and Tron (remember 

that film?). Well, I tried to utilize both in the 

design of Tiq Taq. I gave him the requisite 

steampunk accessory of a boiler, as well as 

those highly stylized wheels seen on the Light 

Cycles in Tron.

So with the initial sketch done I began to refine 

the concept, and on this occasion I re-drew the 

whole thing on an A3 pad and used the larger 

format to clear up some visuals on the concept. 

I added a piano keypad to his belly, a few 

switches, dials, and the radar on his head. Once 

happy with the basic look, I took a sheet of 

tracing paper and drew over the pencil lines with 

black ink (Fig.02). I did this in order to have as 

clean an image as possible before scanning it.

Because I was without a scanner on this 

occasion, I took a digital photograph of the 

line drawing instead, exposing it to as much 

even lighting as possible. I used my girlfriend’s 

Canon Ixus camera for this, and thankfully it 

came out reasonably even. I did of course still 

have to tweak it in Photoshop to really clean 

up the grays: desaturating the image, playing 

with the brightness and contrast, feathering the 

edges and filling areas with white, to give me a 

very definitive black and white digitized image 

(Fig.03). 

Now, at this stage I would usually vectorize 

the image using a redundant piece of software 

from Adobe called Streamline, which I still 

have on my antiquated Apple Mac G3. 

However, as I was in Australia and had no G3 

or Streamline to hand, I had to use Illustrator 

CS3 on my girlfriend’s PC instead. I’d never 

used CS3 before as I still run Illustrator CS 

on my Mini-Mac (which was in Australia with 

me). So I had to experiment a little with the 

Trace feature in Illustrator CS3 before finding a 

happy compromise between line thickness and 

accuracy.

Once I settled on a version and saved it as an 

Illustrator legend file, I transferred it to my Mini-

Mac where I could finally begin working on the 

image with the comfort and familiarity that I’m 

used to in Illustrator CS. Phew!
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Within Illustrator CS I began by working on tidying up the line work. Now 

this can be really painstaking, and for this particular project – it was! The 

first step for me, with Illustrator, is to agonize over the image with the 

Bevel tools (Fig.04), refining the lines that the vectorized image translated 

from the inked scan. Sometimes this works well and a minimal amount 

of correction is needed, but at other times, like with this piece, there is a 

great deal of refinement necessary.

Once done refining I continued with the fun part: adding color to the 

selected areas (Fig.05). At this point I wasn’t adding details like highlights 

or shadows, but merely adding color to see what worked. I often 

duplicated the image, trying alternative color arrangements (Fig.06) before 

settling on a final look.

When I was happy with the color I began the process of adding details, in 

particular shadows and highlights. Sometimes I merely added more black 

to an established color area, or I would often, with the Pencil tool, draw on 

top of an area to add shading/highlights – using the Transparency feature 

I could then Multiply or Overlay that area accordingly, with a chosen 

percentage for the desired effect (Fig.07). 

With Tiq Taq, once I was happy with the details, I decided on a subtle 

background so as not to clash with the very busy colors of the robot. I 

quickly added some steam effects using the Pencil tool, drawing white 

cloud shapes and feathering the edges, reducing the opacity for that 

vaporous look (Fig.08).

And that’s how Tiq Taq – 1901 originated, rendered almost exclusively in 

Illustrator. It was fun!

Richard G.D. Baker
For more work by this artist please visit:

http://www.cirqus.com 

Or contact them at:

cirqus@cirqus.com
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1st 28th Wing
Software Used: ArtRage 2 and CorelDraw

Inspiration
The robot is one of my favorites themes 

because there are many interesting details to 

them, for example pipes, cogs, LEDs and the 

like, and their textures cover a whole range from 

shiny to rusty – they can be really varied and 

visually exciting! For this particular robot themed 

challenge, my inspiration came from street 

musicians – buskers. I wanted to create two 

characters: a small and rounded DJ ‘bot, and a 

lanky guitar playing ‘bot. I wanted to place them 

in a city environment, or at least that was the 

plan anyway!

Sketch
First, I made a quick pencil sketch to define the 

forms (Fig.01), discovering the postures and 

working out the relationship between the two 

robots. I refined the sketch to provide a clear 

drawing, trying to use simple forms to build up 

the robots’ bodies (Fig.02).

Values
For this challenge, as you might already know 

by now is my habit, I used ArtRage 2. So I 

scanned the line drawing to a pencil layer, 

changed the layer mode to Multiply, and 

started to block the light values in with large 

brushstrokes on a new layer. First, I defined a 

light gray background, and on another layer I 

started to work on the robots, adding light and 

dark tones with quick paint strokes (Fig.03a). 

I wanted an industrial background, a metal 

bridge or something, with the robots looking 

sharp on a blurry background (Fig.03b). After 

applying some quick values I started adding 

detail, refining forms and cleaning edges. At this 

point, I found that I couldn’t finish the picture to 

the given deadline. So I had two alternatives: 

one was to have it remain an unfinished project 

and try to complete it in the near future; the 

other was to focus the work on just one of the 

robots… 
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I chose the latter option and changed the 

concept, keeping the background design but 

giving it a darker tone and continuing to work on 

the guitar robot’s details (Fig.04a–b). 

I used basic paper textures with the Chalk 

Tool to give rusty effects, and the Pencil Tool 

to find edges and give fine details (Fig.05a). 

The background was too homogeneous, so 

I Googled a free texture, used it as a stencil 

(mask), and painted it over with a darker tone 

(Fig.05b).

Colors
The coloring part was very quick. I picked a 

tawny color and made a new layer, switched 

it to Overlay mode and filled it with large 

brushstrokes. On another new layer, once again 

in Overlay mode (above the first color layer), 

I started working with a reddish-brown color 

to block in the ‘bot. I mixed some lighter blue 

into the background and gave some blue tints 

to the robot to reflect the sky and break the 

monochrome feeling of the picture a little. The 

finishing touch was the addition of a speech 

balloon, which I made in CorelDraw using 

musical notes from a free font set (Fig.06 – 

Final).

Final Thoughts
Much to my regret, I was unable realize my 

original concept in the end, but I hope I will have 

the time to finish it one day, and that it won’t 

end up in the waste bin of my many unfinished 

projects!

János Kiss
For more work by this artist please visit:

http://www.28thwing.com 

Or contact them at:

janos.kiss@28thwing.com
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Making Ofs
Here are the ‘Making Of’ from this month’s top 3 

winning entries...

3rd Marcuswelbey 
Software Used: Flash, Photoshop

For this making of article I will try to explain how 

I developed a character concept using vectors in 

Flash, as well as some Photoshop effects. 

Concept and Sketch
One of the things I kept in mind right from the 

beginning was the time I had for the project, 

so that I could be sure to stick to it. For this 

Amazon challenge I didn’t have much time once 

I’d started, so I decided to begin the work in 

Flash, which allowed me to work with precision 

in my line work, and later finish off the image 

with Photoshop for the lighting, shadow and blur 

effects.

I like drawing girls in all kind of situations, so this 

contest was a real pleasure for me to participate 

in because I felt comfortable with the topic. In 

the initial sketch I tried to find a pose that helped 

me show the personality of my character, 

which in this case was a furtive, wild woman. 

I chose an extremely basic outfit, and gave a 

punk touch to her hairstyle for a more combat 

look. With regards to the composition, I tried to 

focus the attention on the main figure, to make 

the character look as much of a protagonist as 

possible (Fig.01).

Start in Flash
Taking the sketch into Flash, I started by 

using the line the Pencil tool, the smallest 

brush, because this step was just intended as 

a reference to delimit the color zones. Flash 

allows fast and precise editing of lines. 

The painting process is extremely different 

from Photoshop, since instead of working the 

drawing globally, I fill the whole drawing with 

subtle gradients in order to create soft lighting 

(Fig.02). Flash CS3 has a good tool to work with 

gradients – comfortable and intuitive. I hardened 

the shadows using the Paint Bucket Tool with 

the Paint Selection mode toggled, which allowed 

me to work on areas without altering the rest, 

maintaining the brushstrokes’ natural feeling. 

The big difference when working this way is that 

you can’t build up your picture like in a bitmap 

painting. In vector art, you need to have a clear 

objective from the beginning, since it doesn’t 

allow for as much trial and error.

For the background I looked for images 

to use as reference with a certain mystery 

behind them. I decided on a picture featuring 

a waterfall, and this element was fitting with 

what I was searching for at the time. I didn’t 

want to make anything too definite just yet so 

I drew some silhouettes of plants and trees in 

the foreground and gave it a dark tone to avoid 

too much detailing. Since I intended to heavily 

blur the cascade in the background later in 

Photoshop, I didn´t spend too much time on it, 

just simply defined the main shapes (Fig.03).
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I finished up work in Flash by detailing some 

of the character’s features, and removed the 

remaining line work that was left over after 

coloring (Fig.04).

Finish in Photoshop 

I imported all my layers from Flash into 

Photoshop in PNG format, allowing me to be 

able to work with them separately and give 

them different levels of lighting using Hue/

Saturation and Brightness/Contrast Adjustment 

Layers, masking only the desired areas. With 

the elements separated into layers made the 

selection process easier, too. 

To give some texture to the grass I used a 

Pattern Overlay layer (Layer > Layer Style > 

Pattern Overlay) set to Hard Mix with a low 

opacity. The overlay texture was quite large and 

I gave it a slight gradient to add a little depth. 

For the waterfall in the background I made 

myself a radial Gradient Mask from opaque to 

100% alpha, and used a slight Gaussian Blur 

filter on it. That way I was able to grade the blur 

intensity from the center to the borders of the 

gradient (Fig.05).

To create the frame I used the Eraser Tool 

with different paintbrushes simulating slashes, 

varying them to avoid showing a pattern in the 

frame. I tried some tonal changes (Fig.06), and 

ultimately went for a dark, wet greenish tone 

(Fig.07).

Thanks and best regards to all!

Marc Garcia
For more work by this artist please visit:

http://www.2lions.blogspot.com/

http://two2lions.deviantart.com/

Or contact them at:

two2lions@gmail.com
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2nd jpedro
Software Used: Photoshop 

For this stylized Amazon challenge I wanted 

to try and come up with three different takes, 

concentrating on proportions and cuteness. I 

carry a sketchbook with me wherever I go so I 

can get ideas down when I see something that 

inspires me, or I’ll simply sketch people in a 

pub – or, as in this case, explore ideas for the 

stylized challenge!

 

I usually start a drawing with a rather hard lead 

pencil (HB) and use softer mechanical pencils 

in the 2B–4B range for darker values and lines. 

What I like to do with the harder pencils is to 

apply only very light pressure and very loosely 

look for poses that I like. In Fig.01 and Fig.02 

the very light and scribbled lines around the 

knees and feet are still visible; in Fig.01 part 

of the hands and arms are also drawn like that 

– very lightly. All this light line work gave me a 

good idea of what the general flow of the poses 

would be. 

If I like how a sketch is going, I will take it 

forwards with darker, more solid line work, for 

which the softer pencils are then used. This is 

comparable to sketching digitally and drawing 

really rough gestures on a layer, then lowering 

the opacity of that layer and drawing a cleaner 

line drawing on a new layer on top of that. It’s 

possible to cover a lot of ground with only a 2B 

pencil, but I find that using a harder lead and 

applying only very gentle pressure naturally 

prevents me from going too dark with my line 

work too early on.

I generally make sure that I draw not just with 

my fingers and my wrist resting on the paper 

as an anchor point, but I also use my elbow as 

an anchor, and even draw from the shoulder as 

well to get some nice flowing lines. I don’t spend 

too much time rendering the sketches – a few 

lay-ins and areas that are in shadow blocked in 

are enough, since I color my chosen sketches 

later in Photoshop.

With the drawings scanned, I left Fig.01 and 

Fig.02 pretty much untouched and played a 

little with the third one first of all. I used a very 

simple round brush in Photoshop for most 

of the sketching, with Other Dynamics set to 

Pen Pressure. While I liked the simple sketch 

(Fig.03a), making the silhouette a bit more 

interesting by introducing the skull helmet 

with the horns and introducing some basic 

armor elements gave me another option I liked 

(Fig.03b).

So I had four sketches at this stage, all of which 

worked with similar design elements but had 

different emphasis in terms of how they were 

stylized. Head to body proportions is the most 

obvious difference; the simplification of, for 
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example, the facial features and anatomy in 

general is also quite apparent, especially from 

Fig.01 to Fig.03a.

Since I really enjoyed the way my Amazon 

Warrior was holding the sword in Fig.01, giving 

us that mean look from under her eyebrows, 

I decided to go ahead and color that one for 

my challenge entry. I wanted to try a rather 

loose and painterly approach, so the main 

brushes I used were the Chalk brushes, and 

the Pastel on Charcoal Paper, Soft Oil Pastel, 

and Waxy Crayon brushes from the default 

Dry Media Brushes set by Photoshop. They all 

used the same Brush Tip. In Other Dynamics, 

Opacity Control was set to Pen Pressure; in 

Shape Dynamics, Control was also set to Pen 

Pressure, and Minimum Diameter was set 

to 50%. Angle Jitter Control was set to Initial 

Direction. I also used a Chalk Brush Tip in the 

Dual Brush section. 

Once a Brush is setup to your liking, you should save that variant of the 

brush to your brush library. To do that, while in Brush mode, right -click 

anywhere on the canvas, click the little triangle icon on the top right, and 

choose New Brush Preset. The Brush you just created should then appear 

at the bottom of the list. Your list of Brushes can get quite long, and a 

really great way to access your most commonly used Brushes or other 

Tools is by saving them as Tool Presets. I’ve undocked my Tool Presets 

window and have it open all the time, and I have Current Tool Only ticked 

(Fig.04). That way, only whatever Tool mode I am currently working in 

is shown in the list. In this case I am in Brush mode, so all my Brushes I 

saved as Tool Presets are shown in the list, and I can comfortably select 

and switch between them. Say, for example, you are in Smudge mode 

and have found a Brush tip with certain settings that really work well for 

blending: save it as a Tool Preset – that way you can build up a nice pool 

of favorite Tools that you can easily access. 

I have saved a small selection of my Tool Presets for you to try out if you 

like (click on the Free Resources logo to download with this article). The 

Chalk Brushes I was talking about can also be found in there. To load 

them, open your Preset Manager (Edit > Preset Manager > Preset Type: 

Tools, and open the file). 

OK, so for the coloring I went straight for it, laying them in on a Multiply 

layer on top of my pencil study (Fig.05). Using a combination of Overly, 

Multiply and Normal layers on top, I gradually built up the detail in color. 
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I chose to give her red hair and 

green eyes, which gave me a nice 

contrast to work with. 

I flipped the canvas a few times to get a 

fresh view on the drawing, and I changed 

the pose again slightly so that it felt 

more like she was walking towards 

us (Fig.06). I emphasized this even 

more in the final step (Fig.07). The visible 

brush marks from the Chalk brushes around 

the character and the broken up edges on her 

coat and hair were what I intended on achieving, 

so they didn’t need any cleaning up. For my 

finishing touch I did some detailing work in and 

around the focal area, and then I called this one 

done!

Jan Pedroietta
For more work by this artist please visit:

http://jpedro.cgsociety.org/gallery/ 

Or contact them at:

jpedro@jpedro.com

Download your Free 

Tool Presets which 

accompany this 

Making Of
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1st bstsk
Software Used: Flash, 

We all have one of those pictures where we’ve 

thought, “I’m onto something here!” At some 

point though, things go wrong, and that picture 

then gets added to a new folder in your “Things 

to finish someday” section of your hard disk. 

Well, that was the case with this one: when the 

theme was given for July’s challenge, one of 

those forgotten images from about four years 

ago came to mind ... of an Amazon Warrior! 

The pencil drawing was pretty bad, but it had a 

certain feeling of motion to it that I liked a lot, so 

I decided to go for it (Fig.01).

I started the picture from scratch. With time 

having taken my blindfold off, I quickly saw 

where the pencils had gone wrong before, 

so I changed the head size and gesture, and 

tweaked the expression a little. Using my sketch 

as a background and with a color scheme in 

mind, I went into Adobe Flash. This might seem 

like a strange choice for vector based software 

– Illustrator being much more versatile – but 

I frequently use Flash for animation and I’m 

much quicker with it. So I traced the whole 

image, using a thick colored line for most of the 

character, which gave it a great cartoon feel. 

I left some parts without this outline though, 

where I felt it wasn’t needed, like on her hair and 

her weapon. 

To get a nice ink feel I had to trace both sides 

of the line; there are software options to do this 

(not in Flash, though) but I prefer to control the 

line thickness by tracing – it means more work, 

but the results are much more to my liking. By 

controlling line thickness in this way you can 

give perspective to a completely flat drawing, 

since line thickness acts as a sort of depth of 

field (the thicker the line, the more focused the 

drawing). While I “inked” the drawing, I felt the 

freedom to change proportions and to search for 

the right amount of detail – not too much since 

I intended for an animation feel to it, and not 

too little because it had to hold its ground as an 

illustration (Fig.02).

I decided not to use vector gradients too much 

because I wanted to aim for a cartoon look, with 

flat coloring, so the depth had to come from 

line thickness, color temperature, perspective 

and depth of field. To that end I used the 

background. I hadn’t really thought much about 

it until this point, and since the challenge was 

all about the character I made one that simply 

reinforced the character and composition. So I 

went for the complementary color to the general 

tone of the character and painted a green 

gradient (Fig.03). 

I then placed two different layers of trees with 

different scales and transparency levels, and 
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applied different amounts of Gaussian Blur to 

each one of them (Fig.04). With the background 

established I added a couple of branches in the 

foreground and a huge branch connecting both 

planes, to make it a little more crowded and to 

better suggest the scale of the trees (Fig.05). 

Finally, I painted a heavy border in black and 

applied a Gaussian Blur to that as well. The 

effect of this was a gradient darkening towards 

the image’s limits, centering the attention on the 

character (Fig.06).

At this point, I traced a light beam coming up 

from the trees and set the layer to Overexpose 

to complete the effect. I blurred it and carefully 

deleted those parts where the character 

blocked the light (Fig.07). The last step was 

then changing the tone and saturation values of 
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the background to end up with a greenish blue 

(Fig.08). As the finishing touch, I added a slight 

glow to the Amazon character, and overexposed 

her hair a little (Fig.09 – Final).

Felipe Fernández Morell
For more work by this artist please visit

http://www.ffilustracion.com

or contact them at

contactos@ffilustracion.com 
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This tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we will 

explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments using 

a set of intuitive tools.

This technique is used by many contemporary artists and is used as a quick and effective way of establishing 

correct perspective as well as offering a moveable camera in order to experiment with compositions.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing 

to draw complicated scenes, this approach can prove a valuable starting point for producing a template on 

which to paint over.

“The whole selection 
process is very fast 
because of the line 
rendering layer, so I am 
able to define my light 
and shadowed areas in a 
comfortable way without 
being slowed down…”

Download your Free Base 

Image to accompany this 

tutorial here.

http://www.2dartistmag.com/tutorial_resources/issue_044_aug_2009/tutorial01/free_base_image.zip
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Using Google SketchUp as 
a base for Digital Painting

Why use SketchUp?
Google SketchUp is a free programme enabling 

users to quickly and effectively build 3D 

environments using a number of intuitive tools. 

Unlike most 3D packages it is very easy to learn 

and does not require hours of training before 

decent results are achievable. It is very versatile 

and with regards to digital painting can prove an 

invaluable tool in swiftly establishing a correct 

perspective, as well as offering a moveable 

camera in order to experiment with alternative 

viewpoints and compositions. 

An object can be made and then duplicated 

any number of times, so if a structural element 

is repeated throughout your concept then this 

package can quickly and accurately create 

such arrays. It also has a simple-to-use lighting 

system that enables placement of the sun 

according to the month and time of day by 

way of slider bars, thus determining physically 

correct shadows that can be turned on or off at 

the click of a button. These functions mean that 

as an artist wishing to draw detailed or tricky 

scenes, one can use SketchUp as a valuable 

starting point to establish a “guide template” on 

which to paint over.

Installation
In order to install SketchUp, click on the link 

below and go to Downloads on the left hand 

menu. Select the free version which is currently 

version 7 (Fig.01). Choose your operating 

system and then follow the instructions. 

http://sketchup.google.com/

Once installed, click on the application shortcut 

and you will be prompted with the following 

dialogue box in which you are asked to choose 

a template (Fig.02). The scale and type of your 

scene will determine which you choose, but 

for the purposes of this tutorial we will select 

Architectural Design – Feet and Inches.

Toolbars & Menus
When SketchUp starts you will see a screen 

resembling Fig.03. From the main menu click 

on View > Toolbars > Large Tool Set; this will 

access more tools which will appear down the 

left margin. To change the display mode of the 

objects in the scene click on View > Face Style; 

this will show a number of options, as seen in 

Fig.04.

If you also check Views under View > Toolbars 

you will see six small house icons appear 

below your toolbar (Fig.05). These will provide 

quick access to orthographic views, as well 

as isometric. You will notice that I have also 

checked Face Style in the list (highlighted in 

green), which has added some cube icons to 

represent the display modes. 

This is basically where you can customise your 

workspace and add toolsets to speed up your 

workflow. For additional help go to Window > 

Instructor; this will open a window providing 

useful information on whichever tool you have 

currently selected.

http://www.2dartistmag.com
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Basic Navigation
The key orientation tools you will use to navigate 

in your scene are Orbit, Pan and Zoom, which 

you will find on the top toolbar and whose 

shortcut keys are represented by O (Orbit), 

H (Pan) and Z (zoom). These can be seen in 

Fig.06.

The main tools used to directly manipulate your 

objects are Move (M), Rotate (Q) and Scale (S). 

The Scale tool appears on the left hand toolbar 

which you will see highlighted if you press S on 

your keyboard.

Drawing Shapes
One way of using SketchUp is to create two-

dimensional shapes from which you can extrude 

three-dimensional objects. Select the top view 

and then the Line tool (Fig.07) and left-click in 

the viewport to begin drawing. You will notice 

that as you do so, the points will snap to the 

green and red axes, thus easily enabling the 

creation of right-angled structures.

When you finally close the shape by clicking on 

the initial point you will notice the shape turns 

blue, indicating a surface has been made; once 

a shape has become closed you can still edit 

it, however. Using the Line tool, add an internal 

rectangle (see top diagram in Fig.08). To now 

make this edge become part of the exterior 

shape click on the Eraser tool and then on the 

outside edge shown in red.

You can continue to cut into your shape or 

alternatively extend it outwards and then erase 

the necessary lines by using the Line tool 

(Fig.09). Here I have added a walkway and 

also a curved section using the Arc tool. You 

can also draw more organic shapes using the 

Freehand tool (Fig.10).

One other useful function, especially for 

architectural structures, is the Offset tool which 

is situated next to the Rotate tool. This enables 

a shape to be duplicated in order to create 

depth – perfect for drawing walls in a building, 

for example (Fig.11).

With an exterior wall depth, click on the large 

internal shape using the Select tool (black arrow 

on Toolbar) and hit delete. You can then select 

the Push/Pull tool and then click on the wall and 

raise it vertically (Fig.12). You will notice I have 

edited the section where the walkway adjoins 
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To add lighting effects check Shadows which 

is above the Fog label, and to get more control 

over this function go to View > Toolbars > 

Shadows. This will place two slider bars on your 

toolbar which denote the month and time of day. 

By adjusting these you can control the position 

of the sun and direction of the shadows (Fig.16). 

There is a little icon to switch the lighting on or 

off, and besides this there is also another icon 

which opens up some extra parameters that 

the building using the Line and Eraser tools so 

that this was not raised along with the outer wall.

Three Dimensions
When a shape has been converted into 3D it 

can be edited further by using a combination 

of the Line and Push/Pull tools. If you move 

the Line tool along an edge it will snap to the 

midpoint between opposing edges (Fig.13). You 

can then make equally spaced cuts, as shown. 

These new shapes can be pushed inward or 

pulled outward, or alternatively a new shape can 

be drawn and this can then be manipulated.

In Fig.14 I have used the Offset tool to create 

a window shape in the far left rectangle. To 

create the same proportioned window in the 

other sections simply select the Offset tool 

and double-click in each rectangle. To create 

the arches use the Arc tool and then erase 

the horizontal join shown by the dotted line. 

To create windows use the Push/Pull tool to 

move the shapes inwards beyond the inner wall 

surface or until they disappear. 

Using a combination of the tools mentioned 

so far you will have the means through which 

to create and edit a wide range of forms and 

design detailed scenes.

Atmospherics & Lighting
You can add atmospheric perspective in the 

form of fog to your scene. Go to View and check 

Fog, as seen in Fig.15. You will notice that the 

edges on my building have also been switched 

off, which you can control in the menu under 

Edge Style > Display Edges.

alter the tonal range of the shading. You can 

also control whether this affects just the object 

itself or the ground along with it and vice versa.

Additional Tools
A few other useful tools worth mentioning are 

the Tape Measure, Protractor and Dimension. 

The Tape Measure is used to draw guidelines 

which can then be traced over with the Line tool. 

In Fig.17 you can see that the tape measure 

http://www.2dartistmag.com


page 68www.2dartistmag.com Issue 044 August 2009

 Part 2:  Using 3D as a Base for 2D Painting
has created the dotted lines which can be 

used as a guide to draw the windows an equal 

distance from the top and bottom of the block. 

To delete the lines simply use the Eraser tool.

The Protractor is used to create accurate 

angles. Move the tool to the point at which you 

wish to start the angle and you will see how it 

snaps to the three axes. Click to establish the 

correct plane and then click to begin the angle 

along the appropriate edge. Now you can set 

the angle using the guideline. In Fig.18 I have 

used the near corner as the starting point, which 

I will mirror on the opposite corner.

Once the guidelines are drawn, trace them 

using the Line tool, as with the Tape Measure. 

In Fig.19 you can see that the two angles have 

been drawn and then the Push/Pull tool was 

used to extrude a roof shape across the base 

block.

The Dimension tool simply adds a label to 

your scene, showing the distance between two 

points. Click and drag from A to B and then drag 

up or down to set your dimensions, once again 

using the Eraser tool to delete when necessary 

(Fig.20).

Cameras
The camera in SketchUp is initially placed at an 

average eye level height, so for example when 

you click on the Position Camera tool it will 

zoom in and appear around head height from 

the ground. In this sense scale is an important 

factor in your scene. 

In Fig.21 you can see a cross where I intend to 

position the camera, after which the viewpoint 

will resemble the inset image. The character has 

been placed in the scene to demonstrate the 

relationship between the scale of a character 

and the initial camera height. To adjust your 

camera, use the Look Around tool represented 

by the eye icon.

One final tool which may prove useful is the 

Section Plane tool which allows a view of a 

cross-section of your object. To use this click 

on the tool and then align the green icon to the 

corresponding plane or angle you wish to view. 

Then select the Move tool and click on one 

of the corner arrows and drag in the relevant 

direction (Fig.22).

This concludes our overview which I hope has 

at least introduced the main tools and their 

functions. There are of course further lessons 

to learn along with other tools and techniques, 

such as applying materials, but the main aim 

here is to introduce the interface and value of 

the software in terms of building a simple 3D 

environment which can then be used in digital 

painting. 

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com/

Or contact them at:

rich@3dtotal.com
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the settings in the dialogue to high resolution 

values, like those shown in Fig.03. This method 

generates a clean line rendering of the scene, 

which I will import into Photoshop now. Because 

it’s black and white I can put it on a new layer 

and set its mode to Multiply. I’ll also lock the 

layer completely because I don’t want to 

accidently paint into it later.

and there I switch off all extras, to get rid of 

everything else but pure black lines. I also do 

set the background color to white and switch off 

sky color (Fig.02).

Step 03
To render the selected view, I choose Export 

> 2D Graphic from the File menu, and adjust 

Using 3D as a base for  
2D Painting
Software Used: Google SketchUp and 

Photoshop

In this tutorial I’m going to talk you through the 

process of creating a rough 3D mesh in Google 

SketchUp for use as the base of a moody 

environment painting in Photoshop.

Step 01
Fig.01 shows the mesh I am going to use as 

base for my painting. It’s basically just a few 

rectangular and circular shapes extruded to 

form a building with one open side. SketchUp is 

ideal for creating quick base meshes in perfect 

3-point perspective. You can even define some 

camera parameters, like Field of View, to get 

different types of perspective. In my case, I 

adjusted the Field of View by going into Zoom 

mode and typing 40mm into the input field at the 

lower right. Now the scene looks like it was shot 

with a 40mm lens!

Step 02
To prepare the scene for some over-painting in 

Photoshop, I don’t prepare any mask renders 

like what has been shown in the first part of this 

tutorial. I rather prefer to do a high resolution 

line rendering of the scene to have a great 

tool for quick selections using Photoshop’s 

Magic Wand Tool. To do this, I open the Styles 

dialogue window from the Windows menu, 
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Step 04
Now that everything is prepared we can start 

with the painting. From here on it’s a normal 

painting process, with one little difference being 

that I can use the line rendering to select large 

areas very quickly. To do this I select the locked 

line rendering layer and use the Magic Wand 

Tool to select the first areas I want to fill with 

color. For this image I have a dark, rainy scene 

in mind, so I fill the background layer with a 

grayish blue color as a starting point (Fig.04).

Step 05
The next steps are pretty repetitive: I select 

areas with the Magic Wand Tool and paint in the 

basic lighting of how I imagine this place to be 

lit. I start by defining the darkest areas first, and 

adding brighter areas throughout the process. 

I tend to paint these values low in contrast. It’s 

much easier to increase contrast later than to 

reduce it. Fig.05 shows how the image looks 

after five minutes of painting. 

The whole selection process is very fast 

because of the line rendering layer, so I am 

able to define my light and shadowed areas in 

a comfortable way without being slowed down 

needing to use the Lasso tool too often. I also 

separate layers of darkness and light to be able 

to make adjustments more easily. Of course, 

you could do it all in one layer, but it doesn’t hurt 

to have layers, and maybe they’ll help you later 

on if you want to repaint parts of your image.

Step 06
Because I think it is OK as it is at this stage, I 

am using the Image > Adjustment > Levels to 

increase the contrast a little before I start to fill 

the scene with details. Since there are none of 

these details in my 3D base geometry, I’ll be 

painting them without the 3D rendered guides, 

so I’m starting here by drawing some lines onto 

a separate layer to define a denser perspective 

grid (based on the original geometry rendering). 

I can then start painting in details loosely, 

following the guides just added (Fig.06).

Step 07
While painting the details, I am still refining the 

lighting of the scene by defining more and more 

areas with the help of my line rendering as a 

guide. Until now I’ve used almost exclusively 

Photoshop standard brushes. This is because, 

until now, it has been more important to me to 

have the right colors and lighting than to use 

any fancy brushes. 

I’m painting in some details on the ground now 

to give the viewer a better understanding of 

size and perspective of the scene. And since 

light reflections on water always look nice, I’ve 

decided to paint in a puddle of water which will 

also help to draw attention to the bright lights 

inside the building (Fig.07).

Step 08
Because I think that the whole image could 

use some more “visual noise” here, I create 

a new layer on top of all others and fill it with 

a concrete texture from my texture library. 

(Texture libraries for 3D programs are a great 

resource for such textures. Try CGTextures.

com for free textures to use in your paintings.) I 

set the layer mode to Soft Light and adjust the 

layer’s Opacity a bit to blend the texture nicely 

into the background. But this doesn’t quite 

work without erasing large parts of the texture. 

Without erasing them, the viewer’s eye would 

easily recognize the overlay as a single texture. 

After erasing, the texture layer alone looks like 

what can be seen in Fig.08. 
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Step 09
I adjust the Levels again here for the whole 

image to give it stronger highlights and darker 

shadowed areas because I’ve decided just now 

that I want to make the scene darker still. I don’t 

know why but concept artists seem to love dark 

paintings. Maybe it’s because they are easier to 

paint? By that I mean that you can hide a lot in 

the dark! To darken the image, I place another 

layer over my background image and set it to 

Multiply once again, painting in some darker 

areas with a dark desaturated blue color. The 

new dark areas work like a frame for the parts of 

the image where i want the viewer to focus their 

attention (Fig.09).

Step 10
It’s now time to add some rain – on a separate 

layer – to push the depressing mood of painting 

a bit more! For the rain I choose a color slightly 

brighter than the ground, and an almost white 

shade for the areas where the lights in the 

background lighten up the raindrops (Fig.10).

Step 11 – Final 
As the final step I decide that some sharpening 

will help the image in certain areas, so I flatten 

the whole image, duplicate the resulting layer, 

and apply an Unsharp Mask filter with very low 

values to the new layer (Fig.11). Because I don’t 

want the image to be sharpened completely, I 

take a large Soft Round brush and erase out the 

parts of the mask where I want the image to be 

less important.

And with this final step done, I can call the 

image complete (Fig.12 – Final). I hope this 

process has been helpful, thank you for reading 

along with this tutorial.
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Alex Broeckel
For more from this artist visit:

http://www.alexbroeckel.com

Or contact them at:

alexbroeckel@googlemail.com

Download your Free Base 

Image to accompany this 

tutorial here.
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An artist’s brushes have always been a vital part of any painter’s set of tools, and remain the 

single asset that links paint with canvas. As such, they are crucial to how we view and interpret 

an artwork, and they afford the artist with a means through which to convey an idea or feeling. 

This has always been true throughout the history of art, and is no less important within a digital 

context. Software such as Photoshop and Painter essentially combine and fuse paint, canvas 

and brushes into a single tool. However, within this complex set of “tools”, brushes retain certain 

autonomy with their own, distinct set of parameters and presets, offering artists the freedom to 

affect and vary the way paint is applied. This principle of customizing brushes forms the focus of 

this set of tutorials, and aims to show how individual artists exploit these techniques to achieve 

some interesting results!

“The best way to learn 
with custom brushes is by 
playing with the settings. 
As you can see from this 

tutorial, making your own 
brushes in Photoshop is 

not hard at all.”

Download your Free 

Brushes to accompany 

this tutorial here.

http://www.2dartistmag.com/tutorial_resources/issue_044_aug_2009/tutorial02/tutorial02_custombrushes.zip
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Rock/Metal/Stone Textures
Software Used:  Photoshop

Introduction
I have been asked on many occasions by people, how I create these rock 

textures that very often appear in my illustrations – on walls, backgrounds, 

even on characters. The secret is a rare passion for painting stones … as 

well of course a set of custom brushes for this purpose, which I am going 

to now share with you all. 

We are basically going to be working with two kinds of brushes: a metal 

chain brush and a rock/stone brush. So let’s being – starting things off 

with the stone brush. 

Rock/Stone Brush
The first thing we need to do is to find a nice stone picture for our texture 

library. For this tutorial I’m going to use a free texture from 3DTotal, one of 

my favorite texture resource sites (Go to www.3dtotal.com > Free Stuff > 

Textures) (Fig.01).

Before we start, you’ll need to understand how brushes work. The texture 

image we are going to be using for our new brush will be desaturated, 

which means it will have no color at all. White in a brush will represent the 

transparent color, and black will be a solid one. The different shades of 

gray will work as levels of opacity. For our first brush we don’t need too 

many shades of gray because the image will be very transparent, and we 

need a more solid color for our stone.

Open the texture up in a new Photoshop document (I’m working with 

Photoshop CS3, but this tutorial can be followed in any version of 

Photoshop). Press Ctrl + U to desaturate the image (remember that the 

brushes work in black and white so you don’t need color), and tweak the 

Levels adjustment (go to Image > Adjustments > Levels) until almost all of 

the gray tones have been eliminated (Fig.02).

We now have a nice black and white texture with the correct levels for our 

new brush, so the next step is for us to decide on how our brush is going 

to look. Select the Eraser Tool, and with a soft paintbrush erase anything 

that you don’t want to be part of the brush, trying to create an irregular 

shape. To improve our texture we are going to deform it using the Warp 

function (go to Edit > Transform > Warp). Try to match the shape of that 

shown in Fig.03. 
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Another way of doing this is using the Liquify Tool. Some people prefer 

this way because it is more visual and you have more settings to tweak, 

but I always use the Warp tool – it’s simple and quick.

The texture is now ready to become a brush. Go to Edit > Define Brush 

Preset, give the brush a name, and then hit OK. And voilà! Our brush has 

now been created. You will find your brush available in the brush menu 

(you can right-click on the canvas for a shortcut to it). 

With the easiest part done, we now need to modify the settings to 

improve our new brush. So click on the Brushes tab on the top-right of 

the workspace, and in the Brush Presets select Brush Tip Shape. In the 

window that appears on the right of the Brushes tab, we are going to 

modify the Spacing percentage to 16, leave the Angle at zero, and let the 

Roundness remain at 100% (Fig.04). If we test our new brush we will see 

that it still needs some more work in the Brush Preset settings – the stroke 

looks strange and is much too repetitive.

The next preset we want to explore is Shape Dynamics (Fig.05), so 

select it and you’ll then be able to set the Angle Jitter Control to Direction, 

meaning the shape of our brush will now follow our graphics tablet or 

mouse direction. Getting around the Direction control is one of the most 

important aspects of this custom brush technique, as we will be able to 

see later on when we create our metal chain brush.

Moving onto the Scattering options now, we’re going to set Scatter to 

85%, and we’ll leave the Count at just one. With this preset the brush will 

repeat itself and overlay the strokes, as we can see in Fig.06. Now for the fun part! Let’s select Color Dynamics now; you’ll need to apply 

the same settings as you can see in Fig.07. I’m going to stop here for a 

moment to explain this preset. 

If we compare the previous image (Fig.06) with Fig.07, we can see that 

the stroke is monochromatic – just with one color and lifeless. As we 

know from experience, rocks and stones have different color values, light 

variations and characteristics that make each one unique. Some stones 

have green from moss growth, or violet from weathering by the elements. 

Well, with these presets, you can play with the color, brightness and 

saturation of your brush. In Fig.07 you can appreciate the different color 

values and light variations with just a few simple changes on the controls. 

So at this step I’m going to recommend that you find the value you like the 

most for your own brush – as you can see it’s easy and the possibilities 

are enormous!

Last but not least, we have the Other Dynamics preset to play with 

(Fig.08). Let’s change the control of the Opacity Jitter to Pen Pressure; 

however, if you’re working with a mouse and not a graphics tablet you 

won’t be able to utilize this option. 
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Right-click on your canvas now and select New Brush Preset so that we 

don’t lose any of the changes we’ve just made to our new brush. And 

that’s it! – Done! Easy and simple! Here is how our new brush looks 

(Fig.09). If we test it out we’ll discover that it has pressure opacity, pen 

direction and refined color variation – perfect for painting rock and stone 

textures!

Our rock/stone brush is now complete, but there is still the matter of metal 

to cover, so let’s now get started on creating our very own metal chain 

brush. 

Metal Chain Brush
The first step is the same as before: find a texture of a metal chain. The 

difference this time is that we need to make it tileable. To do this, choose 

the Rectangular Marquee Tool and select from the centre point of two 

links in the chain, as shown in Fig.10. 

Copy and paste this into a bigger document. By pressing Ctrl + J you can 

duplicate the layer; you’ll then need to flip it by going to Edit > Transform > 

Flip Horizontal. See if the chain links are looking correct at this point, and 

check if they are tileable (Fig.11).

When you are happy with your new tileable chain texture, follow the first 

steps of this tutorial once again as you go through the Brush Presets, 

finding the right settings for your new brush. Remember to set the 

Direction Control of the Angle Jitter preset, and focus on the Spacing 

percentage. For this chain brush I have gone with a high percentage of 

Spacing because I need to tweak the space between every link in my 

chain; if you use a low value your links will be too far apart from one 

another other. On the other hand, if you use too high a value then you 

may finish up with a weird shape overall and no links at all! So play around 

and see what you can come up with, remembering to save the Brush 

Presets each time you find a brush that works for you – you can save as 

many variations of one brush as you like, the limitations are endless!

Conclusion
The best way to learn with custom brushes is by playing with the settings. 

As you can see from this tutorial, making your own brushes in Photoshop 

is not hard at all. I would like you to take this tutorial as a starting point 

of the future of your custom brush collection. Enjoy using them in your 

illustrations – hopefully you can have as much fun with them as I have had 

creating this tutorial for you. 

Note from the Editor: Carlos Cabrera, as part of this tutorial creation, 

has created not just two new brushes, but 13 fantastic new rock, stone 

and metal custom brushes that are downloadable only with this tutorial 

– simply click on the Free Brushes icon and get them loaded into your 

Photoshop to start painting today! 

Download and save the ABR file, open up Photoshop, select the Brush 

Tool, click on the little down-pointing arrow next to Brush in the top menu 

bar to open up the brush menu, followed by the small arrow in a circle on 

the top right of the brush menu – select Load Brushes, then go back to 

your brushes menu and you should see the 13 brushes sitting there just 

waiting for you to begin your new painting experiments. Enjoy!
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For more from this artist visit
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“…when you look at 
these sketches, it is clear 

what was going on in 
my head. And sometimes 
that’s as far as a concept 

needs to go in order to 
communicate to others!”

This series of tutorials aims to show some of the methods and processes used to design and develop characters 

from initial thumbnail sketches through to a final concept. The series will be divided into five parts and will focus on 

the general design methods commonly used by character artists. It will begin with quick sketching techniques used to 

suggest ideas and develop a theme before moving onto creating variations once a subject is established. The third 

instalment will culminate in a finished concept design, after which we will move onto the importance of posing your 

character and the impact this has on their personality. The series will conclude with a chapter dedicated to choosing 

suitable eye levels and camera views to best convey an emotional state or emphasise a storyline.

Chapter 1 | Thumbs & Silhouettes

Chapter 2 | Visual Brainstorming – Variations on a Theme

This chapter will resume where the previous one left off and will build upon a decided theme 

and character type. It will essentially comprise of creating variations centred on a specific 

design. Aspects such as proportion, clothing, props and facial characteristics are but a few 

of the topics covered.

Chapter 3 | Speed Painting & Concept Design

Chapter 4 | Dynamic & Exaggerated Poses 

Chapter 5 | Camera Placement, Framing, Fore-shortening & Distortion



page 83www.2dartistmag.com Issue 044 August 2009

Dynamic Characters - Part 2: Visual Brainstorming – Variations on a Theme

Part 2: Visual 
Brainstorming – 
Variations on a Theme 
Software Used: Photoshop

Introduction
When the folks at 3DTotal contacted me to write 

an article on visual brainstorming for character 

design, I thought: What a great opportunity to 

show something different! Artists often spend 

hours, days, weeks, even months working on 

an illustration secluded from the world, at home 

or in the designated studio space. We may 

show our work in progress to family, friends, 

and sometimes we’ll show our roughs to other 

fellow artists for feedback, to make sure we’re 

on the right track, but no one else gets to see 

you making it. And when the illustration is done, 

we then proudly show it off, email it to friends, 

post the finished piece on the web, in popular 

online communities, let it out so the world can 

see via this amazing tool that connects all artists 

throughout the globe: the World Wide Web.

Sometimes we do get to see the process if 

the artist keeps files of all the work in progress 

until completion or even records a video of the 

making of it. Time-lapse videos are always cool 

to watch, and very informative too. But what 

about a recording of what went through the 

artist’s mind? What went through his/her head 

before he/she sat down to create that piece of 

artwork? We don’t see that often. We can look 

at someone’s sketchbook, but more often than 

not sketchbook drawings are already intended 

for show, or to be posted in blogs – even sold at 

conventions. There’s still a disconnection there: 

a big gap from thinking about an art piece and 

creating it.

Visual brainstorming is the only way to truly 

take a peek inside an artist’s brain. And it’s the 

language visual artists use to bridge this gap 

between thought and execution.  Every artist 

does it, in one way or another. If you’re an artist 

or an aspiring one, you may not have noticed 

but you do it already; when you do thumbnails 

on a napkin that no one but you can make up 

what it is, when you write notes next to these 

doodles (a handwriting sometimes only you 

can read), or when you simply research images 

online, saving some for reference. These 

studies are not for show or meant to be hung 

in galleries; they’re for you and for you alone. 

You’re not presenting anything to anyone, you’re 

simply trying to funnel all the billions of ideas 

that are going through your brain, trying to make 

sense of it all, figure things out, or at least warm 

up for the task before you get to do it for real.

Inspiration
For this specific tutorial I was asked to come up 

with a design for a warrior. Any kind of warrior! 

It seemed vague at first, but it just so happened 

I was moving from Chicago to Los Angeles at 

the time, embarking on an adventurous road trip 

driving across the United States (with girlfriend 

and cat!). We took our time and spent seven 

days driving by some quite amazing places. 

At the national parks we were mesmerized 

by beautiful sightseeing, and witnessed vast 

landscapes now inhabited by men. We would 

often see mountains with rocks shaped in 

peculiar ways, caused by erosion and severe 

weather/climate changes. Experiencing all that 

helped shape the idea behind the warrior, and 

what the warrior was about (Fig.01 – 02).
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I remember thinking to myself: In the past, 

people must’ve lived here, enduring these harsh 

conditions. Any man living in places like these 

has to be considered a warrior, a survivor. By 

then we were in South Dakota and went to see 

Mount Rushmore with the president portraits 

carved out of the mountain. Not too far from 

the site there was “Crazy Horse”, an even 

bigger, more ambitious, yet to be completed 

sculpture of an Indian riding his horse. At the 

nearby museum we saw many other sculptures 

depicting Indians in a variety of styles. And that 

was when the idea of making a Native American 

warrior came into being (Fig.03 – 07). 

Concept
Expanding on this idea, I wondered: Now, 

what if this warrior is made out of rocks, or 

partly made out of rocks? Or what if he has 

control over stone elements? Like a shaman 

with mystical powers, who has either trained 

for years to master this skill or has inherited 

it from his ancestors. Or maybe, to survive 

the occupancy of his land, he has learned to 

camouflage himself like a chameleon. And as 

a result, he is the sole survivor of his tribe, the 

last of his heritage. Or maybe he was born that 

way, with some sort of mutant power? These 

kinds of “what if” questions are what you should 

ask yourself to get into the mindset of thinking 
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creatively. Don’t turn any ideas down at this stage, even if they seem silly 

at first. You’re brainstorming after all. Any ideas are welcome here.

The next step is to create a direct dialogue between your raw creative 

ideas and images. It’s time to do some exploratory drawings, sketches 

and speed paintings. Remember these explorations are for you and for 

you alone. They don’t have to look pretty by any means. The goal is to 

get your visions on paper, or on the computer 

(myself, I’ve been working straight in digital), 

even if they’re stick figures – that’s OK, as long 

you’re comfortable with how you do it (Fig.08 

– 14). 
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Sketching
So as I start sketching directly in Photoshop 

(using a Wacom Cintiq), I finally get to explore 

all these questions and ideas. Sometimes I like 

what I’m getting, sometimes not as much. For 

instance, I’m not crazy about how young the 

character looks in early drawings. If our warrior 

is really the last of his kind, then he should be 

older, wiser – perhaps the past leader of his 

tribe. And here’s another idea I played with: 

What if he’s mute or never talks? – A silent 

warrior, ever watchful. Just think about it; picture 

yourself in your car (as I was) driving across 

the Grand Canyon, you drive by giant rock 

formations, and far in the distance you see a 

man whose skin is partly made out of rocks – or 

maybe a silhouetted figure, standing over the 

rocks, watching you. How creepy that would be? 

Anyway, as you go on doodling (have fun with 

it!), some questions will be answered, while new 

ideas and questions will come up. Your brain 

feeds you the images and the images feed the 

brain. You can only benefit from this back and 

forth when visually brainstorming (Fig.15 – 19).  
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Variations
Another thing to keep in mind is the importance 

of creating variations. By creating iterations 

over what you have previously drawn, you don’t 

have to start from scratch on every drawing. 

Copy and paste your study and draw/paint over 

it. By doing this, you’re giving yourself options. 

You can look at several versions and compare 

them next to one another. And the ones you 

respond to the most are the ones you are going 

to end up keeping. In this later stage of visual 

brainstorming you’re now making some choices, 

discarding some ideas and continuing on with 

others. But that’s not say you can’t go back on 

it. That’s the beauty of digital medium – take full 

advantage of it (Fig.20 – 25). 
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Refining your Concept
Once you have something promising, then it’s 

time to stick to it and spend some time refining 

it. And I don’t mean add detail to a sketch; I 

mean play with the same idea but looking at it 

from slight different angles. Another thing that 

refining an image will do is to up the wow factor. 

Sometimes an early sketch nails an idea, but 

often you can come up with more dynamic/

cooler ways of conveying that same idea (Fig.26 

– 32). 

I’m not going to show a finished design for my 

Native American character. This is not what this 

tutorial is about. Being able to render is not as 

important as being able to convey your ideas 

with clarity. Even though these were not meant 

for showing, when you look at these sketches, 

it is clear what was going on in my head. And 

sometimes that’s as far as a concept needs to 

go in order to communicate to others!

I have documented a series of thoughts/triggers/

questions that went through my head, put in 

order, as follows:

• National parks – harsh conditions – 

  warrior’s habitat – warrior is Native 

  American

• Rocky Mountains – rock shapes resemble 

  human faces – warrior is partly made out 

  of rocks – warrior camouflages among 

  rocks – rocks are ornamental – rocks are 

  like parasites; they grow on him – warrior 

  controls rock element

• Warrior is young – warrior is too young –  

  warrior is old and wise – warrior is last of his 

  kind – warrior doesn’t talk, ever

• What does his full body look like? – He 

  should have some clothes on – he’s got a 

  bare chest – he should look more natural – 

  warrior is butt naked – warrior has face 

  (war) paint (scarier!) – warrior has war paint 

  all over his body – play with war paint 

  pattern design

And so on.
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Final Thoughts
Although I have just showed you in this article how I went about visually 

brainstorming a warrior, keep in mind that this is just one way of doing 

it. This process is very unique to each artist and varies based on the 

assignment. In any case, it’s a very powerful tool to help you think 

creatively, to come up with unique ideas and think out of the box. I 

suggest devoting more time to it, if you haven’t already. Don’t worry too 

much about the quality of the images you’re producing. Rather, witness 

how your brain responds to visuals, see where your imagination takes 

you, and enjoy the ride!

Bruno Werneck
For more from this artist visit

http://www.brunowerneck.com 

or contact

contact@brunowerneck.com
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Beginners Guide to Digital 
Painting – Chapter 2

Software Used: Photoshop

Introduction
Please forgive me for skipping any kind of 

“motivational speech” and jumping straight into 

the deep end:  What we will be looking at in 

this chapter of the series will be a mix of more 

technical (sorry, we won’t be able to get around 

this) and some artistic stuff, so I hope you‘ve got 

used to your graphics tablet and had a snoop 

around Photoshop‘s Workspace in my absence 

to better familiarize yourself with everything.

We’ll be going through Canvas Settings, how to 

optimize scanned drawings and sketches, use 

of the Layers, Colors and some basics on Color 

Theory, as well as using the Swatches and 

Color Picker, and some more fun stuff regarding 

Brushes, namely making your own brush sets. 

All this should gear you up for the next step 

in the digital painting evolution, and we can 

actually start painting. 

So, how about we just get started with the 

chores, so we can get to the fun parts a bit 

quicker?

Traditional Digitization, 
Transparency Settings and 
Triadic Tonal Values … 
(because it sounds good!)
Let’s start with something that is a hugely 

important part to digital painting, in more than 

one way: Canvas Settings and preparing 

scanned sketches for work in PS. The latter 

I found important to include, because most 

people start their artistic path on paper, and 

many – even after years of digital painting – still 

prefer to get their ideas down on paper before 

beginning work in Photoshop.

Note: From now on I will assume that you know 

how to navigate, click, double-click, right-click, 

and hold and drag things with your pen. Usually 

in PS, to use a tool you have to click, or click 

and hold while dragging the tool tip over the 

canvas. I don’t know what settings you 

have chosen for your Pen, so all of this is 

up to you to know.

Last month we briefly brushed over 

opening new canvases, so let’s go back 

there and look at it in a more in-depth 

fashion.

After choosing File > New, you are 

confronted with the now familiar Canvas 

Settings box (Fig.01). We covered the 

Preset dropdown, and I would assume 

the Name option is self-explanatory. You 

don’t have to name your file yet though 

if you don’t know what to call it; 

you can wait until you save it for 

the first time. 

Then there is Width and Height 

– also quite self explanatory. 

You can manually change the 

size of your canvas there. The 

dropdowns next to them give you a 

choice of doing this in pixels, inches, 

centimeters, millimeters, points and 

picas. Let’s say you know you want to 

paint something that is 60 by 40cm, you 

just set it to cm and then type in 60 and 40. 

I personally prefer choosing pixels here, 

because I know how big or small a canvas 

size in pixels will be, and what I like to work 

on. 

The next one is the Resolution. The 

Photoshop Standard is 72 pixels/inch (28.346 

pixels/cm) – or ppi for short. You may have 

heard of something being referred to as dpi 

as well, which stands for Dots Per Inch, and 

generally refers to prints and is the more widely 

used term for this setting. So, to put this into 

context, 72dpi means there are 72 dots in one 

square inch of canvas. 72dpi is the standard 

resolution for images shown online – it loads 

fast, but still is good quality to be viewed on a 

screen. However, even though you paint on a 

screen, and most likely your images will mainly 

be viewed on a screen, here is something to 

consider:

If you were to print a painting with a 72dpi 

setting, the quality would be questionable, 

especially when printing large. Most 

magazines and books ask for images 

at 300dpi – which is the most widely-

used setting for print. The image will 

look a lot smoother and clearer, as there 

is much more density in the image, 

more information per inch – 300 dots 

compared to 72. This also affects the 

memory needed to process such an 

image in PS, and to save it. Remember, 

the bigger a canvas in pixels as well as 

dpi, the more information is stored in it.

So, how big should a canvas be in pixels to 

be good to work on? – I cannot tell you, as it 

solely depends on the computer power you 

happen to have at your disposal. But what I 

can tell you is this: Anything under 2000 pixels 

is almost useless, unless you just want to do a 

speed painting or sketch that will not be used 

for anything but viewing on a screen. In digital 

painting, the phrase “bigger is better” for once 

is true. My preferred canvas size starts at 6000 

http://www.2dartistmag.com


page 94www.2dartistmag.com Issue 044 August 2009

Part 2  Beginner’s Guide to Digital Painting
pixels. This – at 300dpi – gives you a decent 

print size as well, especially if you want poster 

sized prints. Why not smaller? Let’s say your 

canvas is 2000 pixels in Height, at 300dpi, 

the actual print size of that is only one fourth 

of what you see on the screen (24% to be 

obnoxiously precise, if 2000 pixels are 100%). 

Another reason is, you can zoom into your 

image while painting to work on small details 

without having to endure a pixelated view 

(that‘s when you can see lots of colored 

squares on your image rather than smooth 

transitions), as 100% will be quite big.

If this was all a bit confusing, it will become 

clear as we go along through these 

Workshops. So no worries – just nod 

and smile. It will make me happy 

[Grin].

So, set your Resolution to 300 

pixels per inch. – If it kills your 

computer, 150 pixels are also 

acceptable, just not if you are 

working for a magazine or on 

illustrations for a book.

The Color Mode simply gives you 

options in what mode you want to work 

– RGB, CMYK, Grayscale or Lab Color. 

Unless you are specifically working 

for print, in which case CMYK may be 

required, leave it on RGB. The mode can 

be changed at a later stage as well. 

Also, you have a choice here of working 

in 8 bit or 16 bit mode. What does that 

mean? 8 and 16 bit refers to how many 

colors (or color gradients) you will have 

in an image. 8 bit means you have 256 

shades of Red, 256 of Green, and 256 

of Blue, which gives you – 256 x 256 x 

256 – exactly 16.8 million possible colors. 

Quite something, hey?! Not that the human 

eye could actually see all these colors, but 

that’s beside the point. This is the standard 

for a JPG image. Now, 16 bit … you may 

have figured already, gives you even more 

possible colors to work with. Namely, 281 trillion! 

Yep, you read that right. – You may wonder 

what the point in this is, if you cannot even really 

see all the 16.8 million of an 8 bit image. – The 

point becomes apparent when you edit the 

image, especially when working with gradients 

and levels. Sometimes you may have changed 

the levels, and later on aren’t quite happy with 

it and want to change it back manually using 

the Levels Adjustment, and all you get is weird 

blocks of color all over that don‘t seem to be 

blended at all, especially in the darker color 

range if working in 8 bit mode. At 16 bit, this 

doesn’t happen. Again, it’s your choice what you 

want to do here, as 16 bit raises the size of your 

image file and your computer may not be able 

to handle it. 

Then you can choose your Background 

Contents, and as mentioned in the last chapter, 

avoid Transparent. Choosing White gives 

you logically a white canvas, and choosing 

Background Color will give you whatever color is 

currently your background color (remember the 

little colored squares at the bottom of your Tools 

Palette?). But whatever you choose, you can 

change this once the canvas is open, too.

Under the Advanced section you can even set 

the Color Profile if you want it to be different 

from the one PS uses as its default profile – the 

one you set up last time – and change the Pixel 

Aspect Ratio, but that one I never use, and 

quite frankly don‘t know much about other than 

when it comes to printing. So I am sure there is 

someone far more qualified than I to talk about 

that. We’ll just stick to Square, which doesn’t 

mean you end up with a square canvas, but that 

the shape you see is the shape you get. 

Now we‘ve got our canvas settings set to what 

we want (Fig.01a), we can even Save Preset 

so it‘ll be faster to call it up again next time you 

want a new canvas of the same size; it‘s quite 

useful when you know you have to paint several 

pictures of the same dimensions.

Empty canvases can be daunting, and even 

as you progress through the years will always 

remain a challenge. A good one, one may 

hope, but a challenge nonetheless. That’s 

probably why simple pieces of paper seem 

more welcoming to fresh ideas, as they are so 

much more familiar, as is the feel of a pencil 

in your hand. With time, you may become 

more accustomed and able to also throw down 

your ideas on a PS canvas, but let’s stick with 

paper for a second. You’ve got a nice sketch 

or drawing that you would like to work on in 

Photoshop, so what do you do? You have three 

options:

• If your sketch is the same size or smaller 

than the active area of your tablet, you could 

simply lift the protective cover of your tablet, 

shove the sketch under it, and trace it with 

your pen. Here you’ll just have to make sure 

that you make your canvas Fit To Screen 

in View in the main menu, as otherwise 

you’ll be busy for a while trying to match the 

position of your sketch with the position of 

your canvas in PS. It may also be advisable 

to do this on a new Layer on your canvas – 

more to that in a few paragraphs

• Another way, and usually the more 

traditional one, would be to scan your 

drawing. If you just want the drawing as 

a sketch reference for a painting in which 

you will not see the line drawing anymore, 

scanning it at a relatively low resolution 

and quality is just fine. If however you want 

to keep the original lines showing through 

the painting, it would be good to scan the 

drawing at 300dpi. I’m afraid I am not able to 
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If you’ve chosen to do one of the latter two, 

and have your drawing sitting on your PS 

Workspace (Fig.02), then what next?

The first thing I want to do is crop the photo, so 

I can get rid of everything else but the drawing. 

To do this, choose the Crop Tool.         Simply 

place the tool’s tip down in one corner and 

drag it into the opposite corner of the area you 

wish to keep (Fig.03a). Everything that will be 

discarded should you choose to apply the action 

should be grayed out – you can even set the 

explain to you how to set up your scanners, 

as they are all different – and I don’t even 

have one at the moment

• So what do you do if you’re in my shoes 

and really don‘t want to try tracing with your 

tablet? You grab a digital camera and snap 

a picture of your drawing! Make sure to 

do this in daylight, by laying your drawing 

on a flat surface (floor is usually good) 

while standing over it without throwing any 

shadows on the paper. You may also want 

to zoom in a bit, as this tends to eliminate 

the slightly warped appearance of the 

paper – it’s a stupidity of the lens to do 

this. The photo option is not so good if you 

want to keep the lines of your drawing 

visible in the painting, unless you happen 

to own a state-of-the-art high end camera, 

but hey … that’s how it goes

color and transparency of this Shield in your 

options bar. Don’t worry if it’s not quite right, as 

the selection can be adjusted – in height, width 

and even rotation. You see the little squares on 

all four corners and in the centre of each line 

(Fig.03b)? Hover over one of these squares 

and you should get a double arrow showing 

you in which direction you can pull or push the 

selection line. Once your pen touches the tablet, 

you can do that, just be gentle with it, as an 

accidental double-click would apply the crop. 

And if your drawing looks not quite straight, 

you can adjust it by rotating the selection in the 

desired direction: hover your pen outside of the 

selection at any of the corners – you should 

see a curved double arrow appear – on the 

corners, you can change the size of the crop 

diagonally. Once you are happy with your crop 

selection, either double-click on the image, click 

the tick symbol (Commit current crop operation) 

in the options bar, or select a different tool and 

Photoshop will ask you if you want to apply the 

selection (Fig.03c).

In many cases, a scanned or photographed 

image may look too dark or too light, or simply 

somewhat washed out like mine, and we want to 

adjust that. If it is far too light or dark, you may 

want to scan or photograph the drawing again, 

as even Photoshop cannot fix everything!
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Go to Image > Adjustments > Levels and this 

will open your Levels adjustment window 

(Fig.04). I find this to be the best choice for 

initial adjustment, as it doesn’t just go lighter 

or darker, but lets you adjust the midtones as 

well – midtones are the colors in between the 

brightest and darkest present in your image. 

As you can see, you can either adjust things 

with sliders, or manually by entering values. 

Looking at the Input Levels, the slider on the 

left works on the darkness contrast of dark 

colors, the one on the right on the contrast of 

your light colors, and the one in the middle 

adjusts the midtones – sliding it left makes 

everything lighter, and right darker. Try it! 

The two at the bottom, the Output Levels, 

practically overlay your image with white or 

black, washing it out (Fig.04a). Good for certain 

thing, but I rarely use that option. But by all 

means, please play around with it. 

Oh, and if you can’t see anything happening on 

your image, check if Preview is ticked!

The Channel dropdown menu at the top lets 

you choose to adjust all colors at once, or 

Red, Green and Blue (hence RGB) separately. 

The results of doing it separately can be quite 

something, so make sure to have a go at that, 

too.

This is the basic use of the Levels adjustment, 

and if you’re happy with what you’ve got, hit 

OK. If you don’t want to adjust anything after 

all, simply press Cancel. You can also save the 

adjustments, and call them up again later by clicking Load…. When I save these kind of 

things, I tend to do so in the folder I’ve made 

for the image – I’m one of those nerds who 

organizes everything separately, one 

folder per new painting … works 

a treat though, as I don’t have 

to wade through hundreds of 

images to find what I am looking 

for.

Anyhow, there’s also the Auto option, which 

I found never quite works out right. Try it … 

you’ll see. And then there is the Options… 

button, which I tend to find quite useful. It is 

a bit more refined than simply using the Auto 

option. I won’t explain though what you would 

need to do there, as it would get way too long, 

so just play around and see what happens 

when you change the settings. Learning by 

doing (and screwing up) is still the best way to 
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learn when it comes to Photoshop. And please 

don’t through your pen at me for saying that, 

even though that may have been the standard 

answer to all your questions every time you tried 

to ask something.

You may also wonder what the little pipettes are 

for in the bottom right: they set your (from left to 

right) Black Point, Grey Point and White Point, 

and I’ve found them to be highly annoying. To 

use them, click on one, and then click with it on 

your image. When setting your Black Point – 

the darkest shade in your picture – do not click 

on anything that’s light or you’ll end up with a 

fully black image, and vice versa for the White 

Point picker. The results of using them, to me, 

seem far too stark. It may work for actual line 

drawings, but as I don’t do line drawings they 

are not for me. But maybe you find it great 

to work with them, so please do if you want 

to. When you’re done, apply the adjustments 

(Fig.04b).

If you just want to use the drawing as a 

reference sketch for your painting, this usually 

is enough to let you go on your way. But if you 

want a really clean drawing or line art, you 

may well need to work more on it; for example, 

removing potential dust particles that happened 

to have a party on your scanner bed. For this 

there are two tools that can prove useful: the 

Clone Stamp Tool             and the Healing Brush 

Tool. 

The Clone Stamp Tool does as it says: it 

clones things. So let’s say you have a small 

dust spec or smudge on your drawing where it 

should be pure white paper, select the Clone 

Stamp to cover it up. The Clone Stamp uses 

the same brushes as the Paintbrush, so you 

can actually select any brush and size, and 

even apply some other settings to the brush tip 

as well. For covering up smudges, however, I 

recommend the round brush tip with Hardness 

set to 80%, and Opacity set to Pen Pressure. To 

actually use your Clone Stamp, hover over an 

area of pure white paper, press the Alt key on 

your keyboard, and then set your brush down. 

Keep holding the Alt key down, and drag your 

brush over your tablet to the spot where you 

want to remove the smudge. Release the Alt 

key. Now just paint over the smudge – you will 

see that the paper from the unaffected area 

will be cloned onto the smudge. It’s pretty cool 

(Fig.05). If you have more than one smudge 

on your drawing, and want to keep cloning the 

white paper onto the various spots, a simple 

way to do this without having to do the whole Alt 

key thing again is to un-tick the Aligned option 

in the options bar before you hit the Alt key for 

the first time                   .  Un-ticking this box 

lets you clone the same area you selected for 

cloning everywhere on the drawing. Ticking the 

Align box will move your selection spot wherever 

you go on your drawing, keeping the distance 

between selection spot and tool tip “aligned”.
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The Healing Brush Tool works pretty much the 

same way. The only difference with this tool is 

it doesn’t clone anything; it heals – magically 

adjusting the color of the affected area to its 

surroundings, as long as the pre-selected spot 

is clean as well. Try it! This is also a good tool to 

use when there is a lot of color variation in your 

drawing, and none of the colors match the spot 

you need to clean up.

At this point you may feel that some of your 

sketch lines need darkening, or the white 

surrounding them needs lightening. This 

is where the Burn Tool and Dodge Tool          

come in useful. You can find them in your Tools 

Palette, and usually the Dodge Tool is the 

default tool here – it lightens things. To choose 

the Burn Tool to darken stuff instead, simply 

click and hold the Dodge Tool and a small menu 

will pop up that lets you choose a different tool 

of the same category (Fig.06). Any tool in the 

palette with an arrow in the bottom right corner 

is one of those tools that have options. 

Again, the Burn and Dodge Tool – more 

sophisticated in the newest Photoshop version, 

and not recommended for use on anything other 

than black and white images in older ones – 

work with the brush tips and their settings. You 

can adjust the Exposure (intensity) of the Burn 

and Dodge Tool in the options bar, as well as 

their Range, that’s whether you want to burn or 

dodge the Highlights, Midtones or Shadows of 

what you are working on in a dropdown menu 

next to the Exposure (Fig.06a). 

For darkening line art, it’s best to choose a 

relatively small brush tip (round, with medium 

Hardness and Opacity at Pen Pressure), setting 

the Exposure to about 25-30%, and using the 

Shadows option from the dropdown menu, 

as this will specifically target the dark lines. 

Then simply use the Burn Tool like a brush, 

retracing the lines of your drawing (Fig.06b). 

Keep working on the drawing with Dodge and 

Burn until you are happy with the result. In 

some cases this may still not be quite enough 

to ensure a great quality outcome, and then 

I’d actually recommend tracing the drawing in 

Photoshop to get cleaner line art results, and 

this you may want to do on a new Layer.

Layers are probably the best thing since cherry 

flavored lollipops that make your tongue turn 

bright red. To explain what they are and what 

they do, or can do, it’s best to compare them 

to transparent overhead projector sheets. You 

can draw on them, write on them, paint on them, 

even make them different colors and change 

how they affect the layers below them, but they 

will never touch your original canvas until you 

tell them to. This makes them extremely useful 

for when you want to try something but aren’t 

sure if it’s going to work.

So let’s have a look at the Layers tab. To see 

anything there, you need to have a picture open, 

so I’ll stick with my photographed drawing for 

now. To make things easier to understand here, 

I think it’s best I just go through all the little icons 

that are available in this palette, and we take it 

from there.

At the top of the Layer Palette, there are these 

icons:

• Lock Transparent Pixels  

When you have painted something on a 

layer, clicking this icon locks all the pixels 

of the layer that have nothing on them, 

effectively stopping you from painting over 

the edges of what you’ve already drawn. 

This is very useful when you need to texture 

something specific and don’t want the 

texture spill over onto the rest of the painting

• Lock Image Pixels 

This locks up the entire Layer, so that you 

cannot paint on it anymore. At all! You can, 

however, still move the layer around on your 

canvas

• Lock Position 

This locks the layer into position, and thus 

won’t allow you to move it around. But, you 

can still paint on it

• Lock All 

Does exactly what it says on the label: It will 

lock everything on the layer, you can’t move 

it, and neither can you paint on it anymore

At the bottom of the Layers palette, there 

are the following icons:

• Add a Layer Style 

This is the same thing as going to Layer 

> Layer Style – and lets you add some 

nice little effects to what you’ve got on 

your layer. This mainly comes in useful 

in designs and typography. I wouldn’t 

recommend using this all that much when 

painting, as it is usually blatantly visible 

that you’ve used a default effect rather than 

painted it 

•Add Layer Mask 

These are very useful for Photo 

Manipulation. I’ve never used them in a 

painting. Layer Masks are simple: obviously 

they mask things, as in whatever is behind 

the mask you cannot see. If you moved a 

photo onto another photo, but only want 

parts of the new photo visible, you can 

apply a Layer Mask and then, using your 
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Paintbrush and the color black, paint over 

everything you want to be hidden behind the 

mask (it will only hide the new photo parts, 

not the ones from any other pictures you 

have layered there). Painting over it with 

white again reveals what was hidden. To 

make something semi-transparent, choose 

a shade of grey to paint with instead. The 

original photo doesn’t get touched by doing 

this, and you can delete the Layer Mask at 

any time should you wish. Layer Masks do 

not work on empty layers

• Create a New Set 

This adds a folder to your layers, into which 

you can move layers. Let’s say you have 

ten layers, three of them are for your sky, 

three for your landscape, and four for your 

character; you can organize your sky, 

landscape and character layers into folders, 

and thus making everything look a bit more 

organized. It also gives you the option to 

hide the entire group of layers from view with 

one click, rather than having to hide every 

single one separately

• Create new Fill or Adjustment Layer 

This offers you the same options as you 

get by going to Image > Adjustments, but 

with a twist: instead of having to apply the 

changes (in Levels or Contrast or Color 

Balance, etc.) directly to the image, it keeps 

them on a separate layer, so should you 

not be happy with them anymore at a later 

stage you can just remove them instead of 

having to start over. You can also add a new 

Adjustment Layer by going to Layer > New 

Adjustment Layer – a very handy thing!

• Create a new Layer 

Take a wild guess … You can also create a 

new Layer by going to Layer > Create New 

Layer, or by simply using the shortcut, which 

I tend to do. Much faster!

• Delete Layer 

  Pretty self-explanatory again, I would think

By the way, you can move layers around in the 

palette, just by holding them and moving them 

up or down. In the same manner, you can drag 

layers into the recycle bin (to the Delete Layer 

icon).

Now, let’s have a look at the few dropdown 

menus and sliders in the palette:

• Opacity and Fill – These are pretty 

much the same as the options of the same 

name in your Brushes Palette: lowering the 

percentage makes the layer it’s applied to 

appear more transparent. This is great when 

painting translucent fabrics, adding subtle 

textures, adding depth to hair and foliage, 

painting water, fog, ghosts you name it! 

There is never any need to actually paint 

something translucent, all you need to do is 

turn down the opacity of the layer

• And then there is the dropdown that has no 

name (I call it layer options), and by default 

reads Normal. This one is great, too, as it 

gives you lots of options for you to choose 

how your layer appears or interacts with 

the rest of your painting. There is not one 

option in there that doesn’t have any uses, 

and some are more subtle than others. So 

my suggestion to you is this: Open a picture 

in PS, a photo or painting – anything that 

doesn’t just have black and white in it – then 

add a new layer and scribble something on 

it in a few different colors. Anything. Doesn’t 

matter. Then methodically go through the 

Layer Options and see what each one does, 

and how it can be adjusted further by using 

the Opacity and Fill sliders

What else? The icons next to the layers …

• Layer Visibility 

This shows you if a layer is visible or not. 

You can click on the icon to make a layer  

invisible

• Active Layer 

This icon only shows next to the layer you 

are currently working on. To choose a 

different layer to work on, simply click the 

layer you want to work on

• Link Layers 

Clicking on the empty squares next to 

the Layer Visibility icon in layers that 

you are not currently working on makes 

this icon appear, which means that the 

layer you are working on and this one 

are now linked, and for example can be 

moved or transformed together

Images with layers cannot be saved as 

JPGs, as well as some other file formats. 

By default, PS will save them as PSDs – 

and if you plan on continuing work on your 

painting after saving, I recommend saving 

as PSD – layers or no layers – as this is 

the highest quality you can save in.

So what if you want to save it as a JPG, to 

show it online? You will need to Flatten 

the image. Just go to the main menu 

Layer > Flatten Image. This collapses all 

layers into one, the Background (which is 

your canvas).

If you want to reduce the size of your 

painting in terms of memory used, or 

just want to make away with some of 

the many layers you were working 

on and are now happy with, 

you can merge layers 

without flattening the 

entire picture. You have 

two options here: Let’s 

say you have some invisible 

layers on your canvas, because you 

haven’t finished work on them yet but 

they were obstructing your view while 

working on some other layers that you are 

now finished with and want to merge, you 

can go to Layer > Merge Visible. If all of 

your layers are visible, and you still want 

to merge some, you need to link the layers 
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you want to merge, and then go to Layer > 

Merge Linked.

Note: You can only link or merge layers that 

are next to each other. If you link two that 

have one in between them you don’t want to 

link, that unlinked layer will be moved above or 

below the ones you are linking. Layers always 

merge into the layer that is currently the active 

layer. 

Right, with this out of the way, I think it’s time 

to move on to something that will get you 

closer to actually painting something. 

Those of you reading this who already 

know how to paint can skip this whole 

part and go right to the end of this 

article, or almost the end; those of you 

who have no clue how to use colors, 

or anything to do with colors, please 

stay on and I promise I‘ll try not to 

make it boring.

Basic Color Theory
Colors are lovely things. Not only do they 

make stuff look colorful, but they also 

give us signals. We apply certain colors to 

certain emotions or events – red is passion 

as well as danger, black is grief or hatred, 

white is purity, blue denotes peace, yellow is 

a warning, while green is envy as well as no 

danger, or go. We learned that the sky is blue, 

the grass is green, the sun yellow, wood is 

brown, and roses are red. Or are they…?

The most common thing I’ve seen with 

beginners is that they apply colors as they 

know them, rather than how they actually 

see them. And seeing colors properly needs 

practice. Or maybe the translation from seeing 

to applying needs practice, I‘m not quite sure.

I won’t bore you with everything there is to 

know about color theory, as I find that once you 

understand the basics you’re good to go on your 

own way with it, and will learn by applying what 

you‘ve learned.

I think everybody knows the Primary Colors. 

They are Red, Yellow and Blue (Fig.07). Mixing 

these get you three other colors: Orange, Green 

and Purple (Fig.07a). They are known as the 

Secondary Colors. Mix these again with their 

neighbors, and you get the Tertiary Colors 

(Fig.07b). The 12 colors you now have are 

the ones present in the color wheel. Black and 

white are not technically seen as colors, and I 

generally discourage people from using them 

in painting as they make things look flat and 

lifeless. 

So the colors you have in the Color Wheel 

are called hues – them and everything in 

between, the full on saturated colors of the 

spectrum. Colors also have temperatures, and 

are measured in Degrees Kelvin. However, this 

goes a bit too far for this, and I’ll just say Orange 

is the warmest hue, and blue the coolest.

Now, the Color Wheel doesn’t just look nice, 

it’s also useful for choosing your colors. Why? 

Because the way the colors are arranged 

around the wheel has a purpose. Let’s try it with 

this example: light and dark, or black and white, 

are opposites. Pretty obvious! The same applies 

to the colors on the wheel. Pick a color, and the 

one you find opposite is, well, its opposite – or 

Complimentary Color (Fig.07c). Let’s say you 

want to paint a sunny winter landscape, which 

colors would you choose? If the sunlight has a 

yellowish warm tint, the shadows would be the 

opposite: bluish purple. You can also reverse 

this for very cold light. What about a scene by a 

fire? The red orange glow of the flames would 

cast greenish blue shadows.

So there is your very basic color theory. To 

refine this a bit more, let’s see what else there 

is, in a nutshell. Color schemes are not just 

comprised of complimentary colors, and 

if we used just them for painting, we’d 

get very bored very soon. The next step up 

from that would be the Split Complimentary 

(Fig.07d), where you take two complimentary 
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colors but split one of them up. You instantly 

get more color variation. Then there are 

Triadic Colors (Fig.07e) – a nice even triangle 

on the color wheel. There’s also Tetradic 

Colors (Fig.07f), a perfect square, and the 

Clash Colors (Fig.07g), which use two 

complimentary colors with one that sits in the 

middle of them, creating a squished triangle 

on the wheel.

Obviously these are all quite drastic color 

matches, and not too well suited for all types 

of paintings. But knowing about these is 

a good start, as they will pave the way to 

understanding how colors work together, 

or not.

The more subtle color schemes are those 

that could be classed as limited color 

palettes and give you seemingly infinite 

possibilities. Colors are chosen from just 

one side of the spectrum, and maybe have 

a couple of subtle complementaries thrown 

in to “pop” the main colors and let the 

image come to life (Fig.07h).

So what about tints and shades? – A 

tint is generally referred to as a color 

that has white added to it, while 

a shade is a color that has black 

added to it. However, unless 

you’re painting walls, I’ve not really 

heard of anything referred to as a 

tint. Shade is the more widely used 

term for darkening or lightening 

a hue.

Another thing you may want to 

try regarding colors is to see them 

for what they are. There is a famous 

scene in the film Girl with a Pearl Earring 

where master painter, Johannes Vermeer 

asks his maid to tell him what color the 

clouds are. She answers with “White”. 

After a short pause, she retracts that 

statement and names several colors 

which are present in clouds. In short, in 
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a little dropdown to adjust what your Eyedropper 

Tool does. You can either get a Point Sample, 

which means it just picks up one pixel’s color, 

a 3 by 3 Average, which means it gives you 

the average color from three adjacent pixels, 

or a 5 by 5 Average, which does the same as a 

previous, just with a wider range. I tend to keep 

mine on the Point Sample. You can also pick 

two colors by just swapping the background and 

foreground squares (hitting X on your keyboard 

to do that is a timesaving shortcut).

Another way of picking colors is of course with 

the Spectrum Color Picker we briefly covered in 

the last tutorial chapter. Open it by clicking on 

the foreground or background color squares, 

and choose your colors. You may be wondering 

what the little round tick boxes do next to the 

Spectrum Slider (Fig.08). Go on, tick one. Any 

one! – They give you a different choice in colors, 

pretty much like the website I linked earlier. It’s 

fun! And it’s quite helpful if you want to paint in 

a limited or controlled color palette (Fig.08a). To 

get your normal spectrum back, just tick the one 

labeled H.

This color picker is nice, but also a bit annoying, 

as it does not stay open while you paint. My 

suggestion here is to pick your colors before 

you start painting, and paint them onto a small 

canvas which you can then save as an image to 

pick colors from.

Or you could use the Swatches. Let’s open 

the Swatch palette and see what we’ve got 

there (Fig.08b). Not much other than lots of 

color squares, and a small arrow in the top right 

corner. If you click on that arrow, you will be 

nature you rarely find any pure colors, especially 

as light and shadows have a great part to play 

in it, too. During a sunny day, your lawn will look 

very green, but also has variations of yellow and 

brown in it. At night, under a full moon, 

that same lawn will appear a deep blue 

green, with deep brown and hints of 

bright blue where the moonlight reflects 

off the surface. So when you think a 

flower is red or a cloud just grey, look 

again. Try to find the other colors that 

compose the whole.

If you have some trouble with all this, 

or simply are aching for a fully working 

Color Wheel that lets you play around 

and discover colors in a fun way, I 

recommend this website: http://www.

colorjack.com/sphere – there you can 

not only go through all the “formulas” I’ve 

just mentioned, and see how they look, but 

also apply certain medical eye conditions 

to the color spectrum for some interesting 

results, as well as choose between RYB 

and RGB modes. And to top it off, you 

apparently can export your chosen colors 

as Swatches for Photoshop and some 

other programs. I’ve tried it and it didn’t 

work, but if it does for you, that’s great. If 

not, you can always take a screenshot of 

the page (Ctrl + Print Screen), then open a 

new canvas in PS and paste (Edit > Paste) 

the image you’ve just captured from your 

screen onto the new canvas. Flatten it, 

save it and then pick your colors 

from that as you paint.

Which brings me to the next topic: Picking 

colors. Literally!

Color Picking
To pick colors from an image – like I’ve 

suggested with the screenshot of the Color 

Wheel – just choose the Eyedropper Tool             

from the tool palette, and just pick the color 

you want from an image. The options bar has 

presented with a rather long menu (Fig.08c). 

Most of it is self-explanatory, like Load and 

Save, and the list at the bottom are different 

color modes and profiles that you can load as 

swatches. They all have a purpose, but I’ve 

never found them all that enticing to use.

In the bottom right corner are two icons, both of 

which we know from the Layers palette: “Create 

New” and “Delete”. This opens up some options 

here: You can create your personal swatches. 

If you want to start with a clean palette, delete 
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all the swatches currently in it – one by one, 

I’m afraid – by clicking on the Delete icon 

repeatedly. To create a new swatch, you 

need to first pick a color in the Spectrum 

Color Picker or from a picture, and then 

click on the Create New icon – this 

creates a new swatch from the current 

foreground color. Once you have all the 

colors you want in your swatches, save 

them so you can call them up whenever 

you want.

I am not sure if the newer PS 

versions have this feature, but 

Corel Painter X lets you create a 

swatch set from an image – in one 

go – essentially picking all the colors 

present in a photo or illustration and 

turning them into swatches. Very 

useful and time saving!

When working with the swatches, it may be 

useful for you to keep the palette open on 

your Workspace, rather than docking it to the 

Docking Well.

in your Photoshop folder! Sadly there is no fast 

way to go about doing this. You need to right-

click on every single brush and choose Delete. 

Once you’ve done this, you can start making 

your brushes.

The best way I have found to go about 

it is to convert whatever you want to 

turn into a brush to grayscale (Image 

> Adjustments > Desaturate) first. 

Brushes by themselves cannot tell 

if something is in color or not, and 

will only work with whatever colors 

you have set as your foreground and 

background colors. Plus, converting an 

image to grayscale gives you a good 

chance to adjust it for optimised brush 

usage. If you are using a photo of some 

cracked cement, for example, to turn into a 

brush, you may want to soften the edges of 

the photo slightly (paint over them with pure 

white with a soft brush), so that when you use 

the brush if will not have a rectangular photo 

shape.

Let’s see … here’s something I’ve scribbled 

(Fig.10). I like it as it is, as I think (no, I actually 

know) that it will make a useful brush. If you 

wanted to, you could overlay this with some 

more textures, or add bits and pieces to it. Next, 

I make sure to make it very close crop, using the 

Cropping Tool. This makes sure that the brush 

created won’t have any excess empty space 

surrounding it. To create the new brush, just go 

Great! Now that you’ve heard all this stuff, let’s 

bring our focus back to something fun. Brushes! 

Custom brushes to be precise.

Custom Brushes
You may have noticed while playing with 

the brushes in the last chapter that there 

are lots of different brush sets to choose 

from. If not, you can find them like 

this: Open a canvas and select your 

Paintbrush. Open the Brushes to 

choose your brush – and you will 

find that small arrow again in the 

top right corner (Fig.09). Clicking 

on that gives you a menu again, 

with a list of your brush sets. To 

open one of them, you can either 

click on the brush set, and PS 

will ask you if you want to 

replace the existing one 

with the new one, or append 

it. Make your choice. You can 

also just click on Load and your 

browser window will pop up, 

letting you browse through your 

brush sets that way. If you have 

downloaded a brush set from the 

internet, or one came with a CD in 

a magazine, you can load that brush 

set with the Load option only, as the 

list only shows brush sets that are currently 

saved in Photoshop’s Preset Brushes folder. 

Of course you can move new brush sets into 

that folder prior to opening PS: Program Files 

> Adobe > Photoshop > Presets > Brushes. 

Now back to Custom Brushes.

Making your own brushes and brush sets is 

really easy. You can turn virtually anything 

into a brush, from scribbles to photos and 

scanned textures, fabrics or dead insects if 

you like. 

To start a completely new brush set, you 

need to delete all the brushes that are currently 

loaded in your palette. – No, not the brush sets 
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to Edit > Create Brush Preset… and there it 

is (Fig.10a). You can now use it like any other 

brush, and change its settings as you wish in 

your Brush palette. You can even save it with 

new settings, for example if you want it to rotate 

and scatter, just click on the “Create New” icon 

(Fig.10b) and a new brush will be created, 

settings included. Great, hey?!

Once you have created your personal brush 

set, you will want to save it. Just open up your 

Brushes again and call up the menu, and 

click on Save Brushes. This will not overwrite 

anything you already have – PS knows that 

something has changed and will let you rename 

the brush set every time you save one.

Notes: When using Vista, it will not allow you 

to save brush sets in the Brushes folder, for 

some extremely stupid reason (unless it’s just 

my computer being stupid?). You can save your 

new brush set in any folder you want, and also 

call it up again from that folder, or once saved 

move the brushes into the Preset Brushes 

folder.

Also something to remember is that older 

versions of Photoshop may not be able to work 

with brushes that were made in newer versions, 

especially not when you have anything below 

CS. Another thing is that the biggest size an 

image can be to be turned into a brush is 2500 

by 2500 pixels. I’m not sure if this has changed 

in higher PS versions, so my apologies if this is 

inaccurate.

Because I know it can be a bit hard to figure out 

which brushes may be very useful for painting, 

and which may not be, I’ve created a brush 

set for you with the basic brushes most often 

used in painting. Over the next four installments 

I shall add new brushes with every article, 

depending on what we’ll be working on at the 

time. To download your free brushes with this 

tutorial simply click on the Free Resources 

icon.

In Closure
Let me just say that if you’ve come this far, I’d 

urge you to stay on and wait for the follow-up 

chapters, as next month we’ll actually be starting 

to sketch and paint, look at composition and 

perspective, and useful tools to help you draw 

architectural things. For now, however, I really 

need a break … Would anyone care to make 

me a coffee?

Nykolai Aleksander
For more from this artist visit

http://www.admemento.com/

or contact

x@admemento.com

Download your Free 

Brushes to accompany 

this tutorial here.
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http://www.2dartistmag.com/tutorial_resources/issue_044_aug_2009/tutorial04/tutorial04_basiccustombrushset.zip
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Roy Stein, painter of beautiful women tinged with the gothic and the 

macabre, talks us through his Photoshop painting process in this month’s 

making of article, based on recent gallery feature, A New Bride. Inspired 

by a statue of the grim reaper, and driven by a desire to keep his artwork 

unique and in keeping with his original concept, discover the techniques 

behind the art of Roy Stein.

“The notion that it would 
be a frontal depiction of the 
character was decided upon 
early on, I just wasn’t sure of 
the story behind it or the color 
scheme at the beginning.”
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I usually draw the main character and the 

background elements (the grim reapers, in this 

instance) on separate layers, as that way I can 

play around with the positioning until I’m happy 

with the layout. I find that working with a blue 

color allows me to sketch the main forms in the 

best, without being distracted too much at such 

an early stage – probably something I’ve kept 

from my early animation studies, using blue 

pencils.

After spending around 20 to 25 minutes 

sketching I merged down the image layers, 

and ended up with the line art all on one layer, 

above the white background, using the Hue/

Saturation tool to convert the blue lines to black 

in preparation for the next step (Fig.01).

Step 02
The second stage of the process, and perhaps 

the most important, was all about the color 

Making Of ‘A New Bride’
Software Used: Photoshop

Hi, my name is Roy Stein and I am a VFX 

artist and illustrator based in Tel Aviv, Israel. 

In this short “making of” article I would like to 

share with you the process of creating a digital 

painting from the basic idea to the final artwork, 

using my recent image, A New Bride as the 

basis for the explanation.

Concept
With this particular piece I started from the basic 

idea of a dark portrait of a beautiful woman 

combined with some gothic/horror elements 

– which is a genre I already love working with 

and have much experience in. The notion that 

it would be a frontal depiction of the character 

was decided upon early on, I just wasn’t sure 

of the story behind it or the color scheme at the 

beginning. 

On a visit to one of London’s cathedrals, I saw a 

statue that gave me the inspiration I needed. It 

was an early 18th Century depiction of the grim 

reaper covered by a semi-transparent cloth. This 

obviously blew me away, and so I immediately 

sat down to work and came up with the concept 

of death’s minions delivering a girl.

Step 01
I started by opening a new document in 

Photoshop – a tall composition due to the nature 

of the artwork’s subject (a medium portrait). At 

this stage you might want to work on a smaller 

sized canvas, bearing in mind that this stage 

is for finding the lines and composition, and a 

smaller canvas allows you to work much faster 

with little or no lag. 

“…a smaller canvas 
allows you to work much 

faster with little or no 
lag.”
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palette and overall tonality of the image. I 

created a new layer underneath the line art 

layer, and with a large soft brush started to build 

up the general color scheme. 

Now this is my favorite stage, because 

everything you do here will more or less set 

the feel and look of the final piece. I chose 

brownish/greenish tones that were very 

sickening, and provided a great contrast to 

the human skin tones that I wanted to use for 

the girl. Right from the start I knew that typical 

white sheets on white skeletons would be too 

common and not very interesting at all. And 

what I was also looking for color wise was a way 

of framing the girl that would support the line art 

composition from the earlier step (Fig.02).

“I hardly ever use 
sophisticated textured 

brushes…”
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Step 03
In this next step I switched to a smaller brush and increased the hardness 

all the way up. I hardly ever use sophisticated textured brushes, I find that 

you can get a lot from the default circular and chalk brushes, providing you 

keep changing the softness and Pen Pressure to suit your specific task. 

I created a few color swatches for the skin tones of the girl, and started to 

lay down some color. I immediately saw that the peachy skin color shifted 

the delicate balance of the image contrast, so I decided to go with a dark 

hair color for the girl, and to compliment that I created a vignette using the 

same color on the tips of the wings (Fig.03).

Step 04
At this point I totally got rid of the line art layer, and started to render out 

the details on the girl’s dress and the reaper minions. I was careful not 

to go into too much detail here, and to keep as much of the original color 

palette as I could. 

When painting in Photoshop, you have to find the way that’s comfortable 

for you of refining the form. I know a lot of illustrators out there use 

smudging to achieve the smooth result of a finished painting, but I usually 

prefer to glaze blurred layers to achieve a similar effect – it gives me more 

control over the final look, and lets me keep the hard edges of the areas 

I want to be kept “punchy”. I used this technique for areas such as the 

wings and her lower body, which helped a bit by taking the focus away 

from those areas and keeping focus on the face (Fig.04).

Step 05
The last step took the most time and was basically a stage of adding more 

and more detail, such as the falling feathers, and lots of refinement and 

detailing of the girl’s face. I felt at this late stage that the colors were a bit 

off and didn’t quite feel right together, so using Curves and Color Balance 

adjustments, I pushed the red values of the entire image so that it was still 

monochromatic, like I wanted at the beginning, but a lot warmer and more 

unified (Fig.05).

I hope this walkthrough has been helpful to you and that it will give you 

some inspiration for your own digital painting endeavors. Please feel free 

to visit my gallery or drop me an email with any questions. Thanks for 

reading!
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Roy Stein
For more from this artist visit

http://www.roystein.com

http://www.studiorso.com 

or contact

roy@studiorso.com

http://www.roystein.com
http://www.studiorso.com
mailto:roy@studiorso.com


With the release of 3DTotal’s latest book, 

Digital Art Masters: Volume 4, we have 

some exclusive chapters for you...

This book is more than just an artwork 

book. Not only does it feature 

full-colour, full-page images, but each artist 

has given a detailed description, in their 

own words, of the creation process behind 

each piece of published artwork. And 

they’ve done it especially for this book! 

This month we feature:

 
“The Village” 

by Andrée Wallin

http://www.3dtotal.com/books/


The following shots of the “The Village” book pages are featured here in full-resolution and can be read by zooming in...

http://www.3dtotal.com/books/


Digital Art Masters: Volume 1, 2, 3 & 4 
Now avaliable from the 3DTotal shop: 

http://www.3dtotal.com/books/

(Note: if a security dialogue box appears, tick ‘Remember’, then click ‘Allow’)

http://www.3dtotal.com/books/


Interviews
Guillaume Menuel

Articles
Beyond Synaesthesia: Interview 

with Justin Lassen  
by Nykolai Aleksander

 Tutorials
New! Using 3D as a Base 

for 2D Painting: 3  
by Darren Yeow 

  
Custom Brushes: 

 Part 2 - Material & Fabric  
by Nykolai Aleksander

  
Dynamic Characters! 

Part 3: Speed Painting & 
Concept Design   

by Kieran Yanner 
 

Beginner’s Guide to Digital 
Painting: Part 3   

by Nykolai Aleksander
  

Galleries
10 of the Best images featuring 

 

Plus Loads More!
go to  www.2dartistmag.com for full 

details and to purchase  current, back 

issues and 6 & 12 month subscriptions

Image: Nykolai Aleksander 

http://www.2dartistmag.com
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3DTotal About us

Is a resource website for the CG community; 

amongst our growing number of products for CG 

artists, we produce two monthly downloadable 

PDF magazines – 2DArtist and 3DCreative. 

We are based in the West Midlands, in the UK, 

and our intention with our magazines is to make 

each issue as full of great articles, images, 

interviews and tutorials as possible. If you 

would like more information on 3DTotal or our 

magazines, or if you have a question for one our 

team, please use the links below.

Contact Information
http://www.3dtotal.com

http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Lynette Clee 

lynette@3dtotal.com 

Lead Designer > Chris Perrins 

chrisp@3dtotal.com 

Marketing > Jo Hargreaves

jo@3dtotal.com

Partners
If you have a CG community website and would 

like to support 3DCreative and/or 2DArtist 

magazine by showing our banners, please 

contact Lynette Clee at the email address above

http://www.2dartistmag.com
http://www.3dtotal.com
http://www.3dcreativemag.com
http://www.2dartistmag.com
mailto:lynette@3dtotal.com
mailto:chrisp@3dtotal.com
mailto:jo@3dtotal.com
http://www.epilogue.net/
http://www.cgdirectory.com/
http://www.masteringmentalray.com/
http://news.hiperia3d.com/
http://www.vanishingpoint.biz/
http://www.fallingpixel.com/
http://www.krazybov.com/
http://www.cgpad.org/
http://www.fridgemonsters.com/
http://www.ambiguousarts.com/
http://arttalk.ru/
http://www.inspiring3d.com/
http://www.childplaystudio.com/
http://vainsoftgames.xm.com/
http://www.3dhype.com/
http://www.3dm3.com/
http://www.3drevolution.org/
http://www.veegraph.com/



